## Table of Contents

1 Migrating from Version 6 to version 7......6
   1.1 Database...........................................6
   1.2 Options..........................................6
2 Installing Version 7..............................7
   2.1 Licencing.........................................7
   2.2 Using options and data from an existing installation..................................................7
   2.3 File associations................................8
   2.4 Trial mode.......................................8
3 Starting the program.............................9
   3.1 File menu.........................................9
   3.2 Option menu.....................................9
   3.3 Help menu......................................10
4 Options..............................................11
   4.1 Notes on coefficients........................11
   4.2 Setting Options................................11
   4.3 How to create Options files................12
   4.4 Options interface..............................13
5 Databases...........................................24
   5.1 View and edit databases......................24
   5.2 Conductor table................................26
   5.3 Species table....................................27
   5.4 Plant database..................................28
   5.5 Poles database...................................28
   5.6 Constructions database......................30
   5.7 Stays database..................................34
   5.8 Wire files database (US version)..........35
   5.9 Adding a new record to a database........35
   5.10 Import a pole data file......................36
   5.11 Export working set............................36
6 Sag Tension Temperature Module...........37
   6.1 Data to enter....................................37
   6.2 Calculate sag from tension................38
   6.3 Results..........................................38
7 Sag Tension Module – US version...........39
   7.1 Load case tab..................................40
   7.2 Stringing table tab.........................40
   7.3 Conductor Properties tab....................41
   7.4 Trial version....................................42
8 Tipload Module....................................43
   8.1 Creating a new tipload project.............43
   8.2 Print a report..................................48
   8.3 Save.............................................48
   8.4 Open or Merge..................................48
   8.5 Grid functions..................................49
   8.6 Resultants.......................................49
   8.7 Combined bending/compression check......50
   8.8 Interpreting results...........................51
   8.9 Import from spreadsheet......................51
9 Profile Module....................................53
   9.1 New Profile.....................................53
   9.2 Steps in creating a profile - overview......53
   9.3 Ground line – manual entry..................55
   9.4 Ground line - Import a file...................55
   9.5 Poles..............................................56
   9.6 Pole Summary....................................56
   9.7 Pole details tab...............................57
   9.8 Tipload calculations..........................58
   9.9 Pole additions...................................60
   9.10 Insert a pole....................................62
   9.11 Insert a pole array............................62
   9.12 Import a set of pole data...................63
   9.13 Export poles....................................64
   9.14 Conductors......................................64
   9.15 Segment functions............................69
   9.16 Using constructions........................70
   9.17 Conductors - General notes................74
   9.18 Insert object....................................75
   9.19 Zoom.............................................75
   9.20 Planview.........................................75
   9.21 Measure function.............................75
   9.22 Uplift............................................77
   9.23 Right click menu...............................77
   9.24 Component Properties........................78
   9.25 Reports..........................................78
   9.26 Open an existing file........................79
   9.27 Creating a tee-off in a Profile.............79
   9.28 Additional Functions..........................81
   9.29 Limitations in version 7.....................83
10 Importing into the Profiler....................84
   10.1 Easting, northing, elevation – excel file....85
   10.2 Easting, northing, elevation - Text file.......87
   10.3 Easting, northing, elevation - DXF file......88
   10.4 Long section (chainage/level) DXF file.....88
   10.5 Chaineage/level text file....................89
   10.6 Distance, Bearing, Inclination Excel file....90
   10.7 Excel file, easting, northing, elevation, poles, constructions...92
# Table of Contents

11 Pole Strength Module...........................................95
   11.1 Safety factor method...........................................95
   11.2 Limit state method.............................................96
   11.3 Results..........................................................98
   11.4 Limit state method – batch processing.....................99
   11.5 Note on calculation method.................................101
12 Conductor Search window.................................102
13 Stringing Table generator.......................................103
   13.1 Data required..................................................103
   13.2 Generate report.................................................104
14 Conductor Ratings Calculator.................................105
   14.1 Conductor Selection...........................................105
   14.2 Parameters.......................................................105
   14.3 Selection of Rating Type and Category....................107
   14.4 Results...........................................................107
   14.5 Temperature from current...................................108
   14.6 Printing a Report...............................................108
   14.7 Saving a Study..................................................108
   14.8 Opening a Study File.........................................108
   14.9 Calculation method............................................108
15 Line Reactance Module...........................................109
   15.1 Conductor Selection...........................................109
   15.2 Parameters.......................................................109
   15.3 Results...........................................................110
   15.4 Printing a Report...............................................110
   15.5 Saving a Study..................................................110
   15.6 Opening a Study File.........................................110
16 Conductor Spacing module......................................111
   16.1 Calculating maximum sag/span length....................111
   16.2 Calculating cross arm length................................112
   16.3 Common Values................................................113
   16.4 Other functions...............................................113
17 Set up for working stress......................................114
   17.1 Database.........................................................114
   17.2 Load combinations (Options)...............................115
   17.3 Pole top allowance.............................................115
18 Set up for Limit state design.................................116
   18.1 Database.........................................................116
   18.2 Load combinations (Options)................................117
   18.3 Pole top allowance.............................................117
19 Set up for rectangular poles.................................118
   19.1 Poles database................................................118
   19.2 Tipload module.................................................118
20 Set up for US users.............................................120
   20.1 Sag-tension calculations.....................................120
   20.2 Conductor sags.................................................120
   20.3 Tensions.........................................................121
   20.4 Load cases......................................................121
   20.5 Pole strength....................................................122
   20.6 Poles ’n’ Wires, Sag10 and PLS CADD....................122
21 Stay module....................................................125
   21.1 Required information..........................................125
   21.2 Optional data....................................................126
   21.3 Results...........................................................126
   21.4 Sidewalk/Cantilever stay.....................................126
   21.5 Other functions................................................127
   21.6 Calculation methodology...................................127
22 Sag calculator....................................................128
   22.1 Field measurements...........................................128
   22.2 Wave/swing sag................................................128
23 Pole foundation calculator.................................129
   23.1 Load factor......................................................129
   23.2 Calculation method..........................................130
24 MES Calculator..................................................131
25 Batch tipload add-on...........................................132
26 Differences - versions 6 to 7.................................134
   26.1 Uplift.............................................................134
   26.2 Tipload modules.................................................134
   26.3 Pole top allowance.............................................134
   26.4 Plant database..................................................134
27 Calculation methodology......................................135
28 Definitions and Terms..........................................136
   28.1 Blowout..........................................................136
   28.2 Glossary..........................................................136
29 Standards.......................................................137
Version 7 is a complete rewrite of the program from scratch. It has been designed to have a simpler interface than version 6. You can open your version 6 projects but will not be able to save projects from version 7 back to version 6.

**New features in version 7**

- ✔ CAD-type interface in the profile module
- ✔ There is just one tipload module. Options are set for load combinations allowing you to use the module for both working stress and limit state design methods
- ✔ A new sag-tension module that uses the initial/final calculation approach of the graphical method (commonly used in the USA)
- ✔ Tipload calculations are integrated into the Profile module or can be accessed separately
- ✔ Partial ice loadings can be modelled in the tipload module
- ✔ You can drag and drop a file on to the profile and tipload modules
1 Migrating from Version 6 to version 7

1.1 Database

Version 7 has a tool that allows you to convert the version 6 database and options files to the format required by version 7. This tool is found under the Start menu in Windows, external to Poles 'n' Wires.

1. The default locations and filenames of the version 6 file and the version 7 file are entered. Change these only if necessary.

2. Click Process file. You will get a message when the process is finished.

3. All data is copied from the version 6 database.

1.2 Options

The same tool allows you to import a saved version 6 options file (created by the version 6 Options>Load/Save>Save function). Browse to the saved version 6 file then click Process File. This is not one of the options files that are stored in the version 6 program directory. This is a file created by using the Options>Save function in version 6.

Note – not all version 7 options correspond exactly to version 6 options, so after migrating the settings you are advised to check through the version 7 options.
2 Installing Version 7


Install these Microsoft components:


Run the setup package and follow the instructions.

These directories are created:

- [Program files]\powermation\poles 'n' wires program directory
- [Programdata]\powermation\polesnwires data directory

2.1 Licencing

2.1.1 Licence type

You have a choice of licence type. Select Standard unless you have purchased another licence type.

2.1.2 Activation

When you first run Poles 'n' Wires 7 you need to complete an activation request. A licence is valid for one specific computer only unless you have made other arrangements with PowerMation. After the activation request is sent we will send you a licence file by email. When you receive that email, save the attached file. Run version 7 again and browse to the saved licence file. The file will install and the program will open.

If you do not have a licence you can run the program in trial mode. See section 2.4.

2.2 Using options and data from an existing installation

If you have an existing installation and want to use the same options and database with a new installation you can copy files from one PC to another. The files are located in the data directory. You can access the data directory through the Start menu>Program>PowerMation>Poles 'n' Wires shortcut. You will need to copy pnw.ini and the database file (default names are pnwdata.xml for metric setups or...
pnwdata_imp.xml for imperial setups). Copy these files into the data directory for the new installation overwriting the existing files.

2.3 File associations

When version 7 is installed the file extension pnwx is registered on your system and associated with Poles 'n' Wires 7. When you double click on a pnwx file it opens in Poles 'n' Wires.

2.4 Trial mode

In trial mode some functions of the program are limited:

• you cannot open or save project files
• you cannot print reports
• there is a limit of 5 poles and associated circuits in the profiler
• there is a limit of 2 circuits in the tipload module
3  Starting the program

During installation shortcuts to Poles ‘n’ Wires are created in the Start menu (Program files>PowerMation>Poles ‘n’ Wires) and optionally on the desktop.

On starting the program the licence is validated and if all is correct you will see the main window.

From this main window you can open various modules that perform the functions required for overhead line design. Minor modules are located under the “Other modules” dropdown.

3.1  File menu

This gives you access to open a file and has a list of recently opened files. It also has the menu for Databases (see section 5).

3.2  Option menu

See section 4 for details on these functions.
3.3 Help menu

The About menu shows licence and version details.

3.3.1 Email support

This function opens a new email in your default email program addressed to PowerMation Support. In the background it also obtains data from your installation (database file, options and file version information) and uploads it directly to PowerMation for use by support staff in assisting with your enquiry (assuming your computer is connected to the internet at the time). Often this data is needed along with any project files which you’ll need to manually attached to the email.

Some networks won’t allow this email function to work correctly. If you get an error message when attempting to use this function just send an email to support@ipowermation.com using your usual mail program.
4 Options

It is essential that you set options to correspond to the design parameters you work under. You can create “sets” of options that can be loaded before working on a particular project. Usually options are read from the configuration file immediately before any calculations are performed, however it is best to exit and restart Poles ‘n’ Wires if you have made changes to important options.

4.1 Notes on coefficients

Some of the coefficients referred to in various standards are dealt with as follows:

4.1.1 Conductor drag coefficient

This is a field in the conductor database for each conductor. The default value is 1.

4.1.2 Terrain or height multiplier

Can be set in options, defaults to 1.

4.1.3 Pole and plant drag coefficient

These values are assumed to be reflected in the values for wind pressure on pole and plant, so is not explicitly an option that can be set by the user.

4.1.4 Pole top allowance

This allows for crossarms, insulators etc by multiplying the wind load on the pole by the specified value. The default is 1.

Note: In version 6 this variable is used by the working stress tipload module (default value is 1.1) but is not used by the limit state module. In version 7 this variable is applied to all tipload calculations.

4.2 Setting Options

Open the Options module from the menu item on the main window.

- Click Settings to proceed to the options interface
- Click Export option to save the current settings to a new configuration file
- Click Import option set to load a saved configuration file. This will overwrite all
The name of the most recently loaded or saved option set is displayed in the title bar of the Options window.

4.3 How to create Options files

Options in Poles ‘n’ Wires are stored in a text file and accessed when the program is running. You can create different “sets” of options for different clients or regions then save them for later use or to give to other users.

You may start from your existing options and change any as needed to suit the new conditions or requirements.

• When you click Save within the Options module the values are saved to the current configuration file.

• To create a file so you can change sets of values, or give to another user you need to use the Save function located as shown:

Clicking this opens a standard file save dialog. Save the file. This file can be shared with others users so they can access the same options are you have.

• To use the file you have saved previously you need to load it. In the screen shot above you will see the corresponding Load function. Browse to the file and click Open. There will be a message saying the options have been loaded. We recommend you close and restart Poles ‘n’ Wires to ensure all options are reset and available.

• You can load a previously saved version 6 or version 7 options file.
4.4 Options interface

Options are presented by category. Click the tabs on the left to move through the options.

After editing you need to click Save to preserve your changes. There are two saving options:

- Save current options. This saves the current options, retaining the values for ongoing use.
  - If you have previously loaded or saved an external options file you will also be asked if you want to save the changes just made to that external file. Click Yes if so.

- Export Options. You can save the current options to a separate file, allowing you to create sets of options for different design requirements. See section 4.3.

4.4.1 Units

The following table defines the commonly used units in Options and other parts of the program.

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Metric</th>
<th>Imperial</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length/distance</td>
<td>metre</td>
<td>feet</td>
</tr>
<tr>
<td>Pole diameter (or smaller e.g. ice thickness)</td>
<td>millimetre</td>
<td>inches</td>
</tr>
</tbody>
</table>
### 4.4.2 General tab

- database name. `pnwdata.xml` is the default file name. You can create different databases if that suits you. The database is stored in the local data directory by default.

- **Shared database.** If you have more than one user in your business it may be desirable to have all users access the same database. To set this up:
  1. Create a shared directory on a server
  2. copy the file `pnwdata.xml` from the local data directory to the new shared location
  3. instead of the database file name enter the full path to the shared directory in the General tab, including filename eg `\ \server1\pnwshared\pnwdata.xml`
  4. To protect the database from unauthorised editing users need to enter a password. Set the password by running the tool `DBpassword.exe` in the program directory. The password is blank initially.

- Include summary with reports. Ticking this will append a list of all options to any reports you generate

- Tick **Check for updates** if you want the program to automatically check for updates when starting. If an update is available you will have the option to install it immediately or next time you start Poles ’n’ Wires. An internet connection is required to check for updates.

- Default conductor. Select a conductor for insertion in the program when a conductor is required. The default can be overwritten.

- Use metric or imperial units. Tick for metric. Clear the selection for imperial (US customary) units.

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Metric</th>
<th>Imperial</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loads</td>
<td>kilo-Newton</td>
<td>pounds</td>
</tr>
<tr>
<td>Wind pressure</td>
<td>Pascals</td>
<td>pounds</td>
</tr>
<tr>
<td>Temperatures</td>
<td>°Celsius</td>
<td>°Fahrenheit</td>
</tr>
</tbody>
</table>
• Metric wind units. If using metric, you can select to use Pascals or m/s for wind pressure.

• Working set. If you have entered a “Set name” property into database entries you can use it as a filter when you need to select from database items like conductors or pole type in the program. Only entries with a matching set name are shown for your selection. If the working set option value is blank or if no record in the database being accessed has a matching set name then all records in that database are available.

• Standard. A list of Standards that have particular requirements for some functions within the software. See section 29 for details. If you make no selection the default is the Australian Standard AS/NZS7000.

4.4.3 Sag tension

• Standard temperature is set here.¹

• Default tension units – select from %CBL, tension in kN or lb, or use a Table setting (the only Table available at present is the Energex table setting)

• Default span length. Used to complete span length when opening a module or creating a new project.

• Blowout temperature. Used when conductor blowout is calculated.

• Wind pressure – blowout. Used for blowout calculations.

• Tension warning %. Two options, for bare and bundled (multi-core) conductors, to specify a number eg 50, for the program to indicate if a circuit has exceeded the limit set. This is shown:
  ◦ in the metric sag-tension module by a red background in the results table
  ◦ in the tipload module, in the results summary, indicating the conductor, attachment height and direction
  ◦ in the profile module, in pole properties, as for the tipload module

¹ This is the base or reference temperature used for design purposes. ENA C(b)1 described it as “a conductor temperature equivalent to the mean of the winter season temperatures with negligible wind loads ie in still air.” (sect 3.3.2.2). AS7000 says it is “the everyday temperature for the region” (sect 7.3.2.4). HB331 (the AS7000 handbook) recommends “Average ambient temperature for year” (Table 7.2)

This value is usually the same for all projects within the same geographical area and should be specified by the power utility.
• Ice loading. You can set up to 4 loadings, giving each a name, density and thickness.

4.4.4 Tiploads

• Wind angle increment. When the worst case is assessed, calculations are done for each direction around a full circle. This option sets the step. 10 degrees is a suitable step.

• Default number of conductors. When a new component is added to a project that requires a number of conductors this default value is inserted. It can be overwritten.

• Point of contra flexure method. Also called point of flexity or pivot point. If you need to use a point of contra flexure other than ground level you can specify how the program calculates this point:
  
  ◆ Fraction of sinking depth, below ground. Valid values are from 0 to 1. 0 means at ground level, 1 means at the butt of the pole. So if the point is 0.7 of the sinking depth below ground enter 0.7 in the appropriate text entry box in the tipload module.

  ◆ Percentage of pole length, from butt. If the desired point is 7% of the pole length enter 7 in the text box.

  ◆ Distance below ground. Enter a value in metres/feet. A positive value is below ground, a negative value is above ground. For example, to use a point 1m above ground level enter -1 in the text entry box.

![Figure 1: Point of contra flexure entry box in tipload module](image)
4.4.5 Conductor spacing

Options used by the conductor spacing module.

- Line to line voltage in kV
- Midspan separation constant. Normally equal to 0.4. Where local conditions have shown that other values are appropriate you can use those. AS7000:2010 section 3.7.3 gives recommended values for extreme conditions such as high bushfire prone areas.

4.4.6 Conductor Windage

- Wind force on conductor. This setting affects how wind blowing on the conductor is reduced depending on its angle of incidence. Your local utility will tell you which selection to use. If they don’t tell you, we recommend using \( \sin^2 \) since standards such as AS7000:2010 and BN50341 and the American Society of Civil Engineers\(^2\) use \( \sin^2 \) for the angle of incidence. Using “independent of angle of incidence” does not necessarily give the greatest tipload – it depends on the configuration of conductors.

\(^2\) Section 2.1.6.2.1, Guidelines for Electrical Transmission Line Structural Loading, ASCE
4.4.7 Load combinations

These load combinations are used in calculating tiploads. You can create up to 7 combinations, selecting the ones you wish to use for any particular project. For each load combination you need to set:

- Name. A unique name. Leaving this entry blank will prevent a load combination from displaying in the tipload module. If you have a value in Name but don’t have values in the other settings you may get an error in the Profiler.
- Ice loading. Select from the options presented. The ice loadings are defined on the Sag Tension tab in Options (see section 4.4.3).
- Temperature
- Wind on pole. This value includes any factor for pole drag.
- Wind on conductors
- Load factors apply to:
  - $F_t$ - intact conductor tension (horizontal)
  - $W_n$ – horizontal wind loads on pole, conductors etc
  - $G_s$ – vertical loads on pole, cross-arms etc due to their own mass plus the mass of any attachments
  - $G_c$ – vertical loads of conductors and attachments such as marker balls
- Pole strength class. If using the pole database to specify poles in the tipload or profile modules you need to choose which pole strength value applies to the load combination you are creating. The options are:
  - ultimate limit (for limit state method)
  - no wind, wind 1 or wind 2, if using working stress method
- Pole strength reduction factor. Is applied to the pole strength.

4.4.8 Load combination 7

Load combination 7 is a special case that allows you to set wind and/or ice loading that is used by the profile module for sag calculations. You can also set a constant value to be added to the conductor load (for example, as specified by NESC for some load cases). If you use a label for a temperature condition when creating segment in the pro-

---

3 The factor designations are taken from Australian Standard AS7000:2010.
file (see section 9.14.8) that is the same as the label for load combination 7 these details are used for the sag/tension calculation.

4.4.9 Profiler

- Distance below tip. When attaching a circuit to a pole this is the default distance below the tip of the pole that the circuit is attached.

- Default spacing between circuits. When adding circuits to a pole with existing circuits you can select to attach the new circuit this distance below the lowest existing circuit.

- Clearance lines. Set one or two lines to be displayed in the profile window. Enter 0 here to prevent the line from displaying.

- Display span lengths. Tick to show the distances between poles in the profile. The distance is visible under the “ground line”. Two numbers are shown; the upper number is horizontal span length, the lower number is the slope distance (allowing for vertical height difference between the pole bases).

- Default vertical scaling. This sets the relative horizontal/vertical scale in the profile drawing window. You can manually change this at any time within the profile to optimise the display.

- Autosave interval. The frequency in minutes for saving a backup copy of the profile data. The backup files are saved in the system temporary directory. Access this directory by opening My Computer and typing %temp% in the address bar. The backup files are saved as .pnwx files.

- Temperatures. You can set up to 4 default temperatures for display in the profile. When you create a new segment you select which of these to include. Each has a temperature, a label and a colour. Set the colours by clicking the “Edit colours” button (figure 3). This opens a tool window where you can view and edit the default circuit colours associated with the temperatures (figure 4). The colour tool window may be hidden behind the Options window, if so move the Options window aside.
• Background colour. Set the background of the profile drawing window.

• Construction rules file. An Excel file contained attachment spacing rules between constructions. These rules can be used when adding constructions to a pole. The file must be in the format shown:

<table>
<thead>
<tr>
<th>Sub Circuit Construction</th>
<th>Super Circuit Construction</th>
<th>King Bolt Spacing</th>
</tr>
</thead>
<tbody>
<tr>
<td>11A</td>
<td>11P</td>
<td>0.65</td>
</tr>
<tr>
<td>11A</td>
<td>11A</td>
<td>0.65</td>
</tr>
<tr>
<td>LVABC/S</td>
<td>11A</td>
<td>1.8</td>
</tr>
<tr>
<td>LVABC/S</td>
<td>11TD</td>
<td>1.8</td>
</tr>
</tbody>
</table>
• DXF export X and Y scales. When exporting a profile to a DXF file you need to specify the X and Y scales. This option sets the default values. Commonly used values are 1000 and 200 meaning the horizontal scale for the DXF is 1:1000 and the vertical scale is 1:200.

• Use only hot super/cold sub circuits in Measure function. The Measure function gives clearances between circuit. If this option is selected the Measure report displays on clearances between combinations of a hot super-circuit (highest temperature) and cold sub-circuit (lowest temperature). If this option is not selected clearances between all circuit combinations are shown in the Measure report.

• Add to segment length. When producing materials lists you can add a fixed length or a percentage to the total segment (strain section) length, to allow for tying off.

4.4.10 Uplift

• Show uplift indicator. When uplift is detected a red U is placed next to the pole in the profile as an indication. Untick this option to prevent the U indicator being shown.

• Uplift temperature. This value is used to check for uplift in the profile. You do not need to explicitly include a circuit at this temperature in the profile; uplift will always be checked.

• Show uplift on strain poles. If you tick this option the red U will be shown on strain poles, even though the strain construction is designed to accommodate uplift. If you untick this option, the red U will not be shown on strain poles.

• Uplift threshold. Enter a value equal to or greater than 0 to set the threshold for uplift to be displayed. For example, if you enter .1 here, uplift on a circuit less that 0.1 kN (or lbs for US version) will mean the uplift indicator is not shown.

4.4.11 Poles

• Set default length and average above ground diameter as a percentage of the pole length.

• Pole sinking (setting) depth. The equation \( \text{sinking depth} = ax \text{ pole length} + b \) is used to set the default sinking depth. Enter values for a and b.
### 4.4.12 Pole strength

- Default pole diameter in mm
- Default additional load in kg. Used for vertical load calculation

### 4.4.13 Electrical

Options for the Line reactance and Conductor rating modules.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solar absorption coefficient</td>
<td>A measure of the incident solar radiation the conductor surface can absorb, ranging in value from 0 (reflective surface) to 1 (perfectly absorbent surface). As a guide, the solar absorption coefficient is 0.6 for new bright conductors and 0.9 for old or blackened conductors. Values in the range 0.8 - 0.85 are typical for in-service conductors.</td>
</tr>
<tr>
<td>Emissivity</td>
<td>A measure of the efficiency with which the surface radiates heat, ranging from 0 to 1. As a guide, emissivity is 0.3 for new bright conductors and 0.9 for old or blackened conductors. Values in the range 0.6 - 0.85 are typical for in-service conductors.</td>
</tr>
<tr>
<td>Line to Line Voltage</td>
<td>This value is used to convert the current rating into a MV.A rating.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Supply frequency (Hz)</td>
</tr>
<tr>
<td>Relative air density</td>
<td>Air density at the altitude of the project, relative to air density at sea level. A value of 1.0 means the same density as at sea level.⁴</td>
</tr>
<tr>
<td>Design Temperature</td>
<td>The conductor design temperature is set according to the chosen rating type. Values of 75°C are typical for normal ratings. However, higher values may be used for short-term emergency ratings and for new high temperature conductors.</td>
</tr>
<tr>
<td>Ambient temperature</td>
<td>Nominal actual air temperature</td>
</tr>
<tr>
<td>Wind velocity</td>
<td>The user may modify the wind velocity to suit the local weather conditions. Increasing wind velocity affects conductor ratings significantly.</td>
</tr>
</tbody>
</table>

⁴ Equation for air density at altitude available in ELECTRA No 144 October 1992 p113
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wind angle to conductor</td>
<td>Incident angle of the wind to the conductor, ranging from 0 to 90 degrees. An incident angle of 0° means the wind is parallel to the line. An incident angle of 90° means the wind is perpendicular to the line.</td>
</tr>
<tr>
<td>Intensity of solar radiation</td>
<td>Values of 1000 W/m² are typical, but this will vary with latitude and season.</td>
</tr>
<tr>
<td>Ground reflectance factor (albedo)</td>
<td>The ground reflectance factor is the ratio of reflected solar radiation to direct incident radiation. This factor is low for foliage and high for bright reflective surfaces, e.g. pavement or salt flat.</td>
</tr>
<tr>
<td></td>
<td>The value will be above 0. A zero value means there is no additional radiation included. A value of 0.2 for example means add an additional 20%. A value of 0.5 corresponds to an additional 50% radiation due to reflection.</td>
</tr>
<tr>
<td>Use albedo</td>
<td>Tick to default to include albedo in calculation.</td>
</tr>
</tbody>
</table>

### 4.4.14 Span Reduction Factor.

Also called gust response factor. Included with the program is the SRF as specified by AS7000:2010. If you use a different calculation method you can write your own add-on or you can ask us to quote for developing a module.
5 Databases

On the main window is the menu giving access to the databases in the program.

5.1 View and edit databases

Click File>Databases>Open to open a window displaying the available databases. Select a database table from the dropdown.

- Units relevant to the database are displayed on the top border. The table opens as read-only so unintentional edits cannot be made.

- Click Unlock to change the table to editable mode. Click Lock to set the table back to read-only mode. Before changes are saved a backup of the original database file is made to the System TEMP directory in case you need to revert.

- If you have more than one installation of Poles ‘n’ Wires in your business you can use a common database; the location of that database file is set in Options. In this case you will need to enter a password to put the database into editable mode.
mode. This is to ensure only authorised users can make changes to the data-
base.

• To add a new entry you will need to unlock the table.

• After making changes you are asked for confirmation that you want to save the
changes.

• You will need to close and restart Poles 'n' Wires to make the changes available
for use.

• You can use CTRL A to select all records in the database you are examining and
then paste the data into a spreadsheet if you want to save or print the data.

5.1.1 Filter view

Click the Filter menu item to search for items in the currently displayed database.

• Select the field you want to filter on.

• Select LIKE or =. The equals sign will filter for an exact match to the value. Us-
ing LIKE creates a search for the value anywhere in the field's data.

• Click Apply filter to see the results of the filter.

• Click Clear filter to reset the database to view all records.

5.1.2 Database fields

Most parameters for database entries are self-explanatory; the fields particular to Poles
'n' Wires are defined below.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>Unique code in this table</td>
</tr>
<tr>
<td>Name1, Name 2</td>
<td>Alternative descriptions</td>
</tr>
<tr>
<td>Favourite</td>
<td>Tick if this record is commonly used (not implemented yet)</td>
</tr>
</tbody>
</table>
Further details about individual tables are given below and in sections 17, 18 and 19.

### 5.2 Conductor table

Fields specific to the conductor table are shown here. Any fields not marked Optional are required.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Comment</th>
<th>Units (metric)</th>
<th>Units (imperial)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material</td>
<td>Used for filtering/searching purposes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mass</td>
<td>Mass per unit length</td>
<td>kg/m</td>
<td>lb/1000ft</td>
</tr>
<tr>
<td>Nominal outside diameter</td>
<td>Cables are modelled as a cylinder with diameter</td>
<td>mm</td>
<td>inch</td>
</tr>
<tr>
<td>Modulus of elasticity</td>
<td>A property of the combination of material and number of strands.</td>
<td>GPa</td>
<td>10⁶ psi</td>
</tr>
<tr>
<td>Coefficient of linear expansion</td>
<td></td>
<td>/°C</td>
<td>/°F</td>
</tr>
<tr>
<td>Cross sectional area</td>
<td>Total area of the strands (not π . diameter)</td>
<td>mm²</td>
<td>in²</td>
</tr>
<tr>
<td>Conductor breaking load (CBL)</td>
<td>Also called Ultimate Tensile Strength or Rated Strength</td>
<td>kN</td>
<td>lbs</td>
</tr>
<tr>
<td>Drag coefficient</td>
<td>(Optional) Assumed to be 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temperature coefficient</td>
<td>(Optional)</td>
<td>/°C</td>
<td>/°F</td>
</tr>
<tr>
<td>Resistance</td>
<td></td>
<td>Ω/km</td>
<td>Ω/mile</td>
</tr>
<tr>
<td>Insulation</td>
<td>(Optional) Used only for reference and searching purposes. A conductor marked as having Insulation will not be available in the Line Reactance module as that is a calculator for bare conductors only.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stay wire</td>
<td>Not used</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bundled</td>
<td>(Optional) If a conductor is marked as Bundled the Number of conductors will default to one</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Poles 'n' Wires 7  Databases  27
Conductor standards or manufacturers may be able to provide the information necessary for this table.

### 5.2.1 Composite conductors

When entering ACSR (composite) cables into the database you need to follow a specific naming format if you want to use the cables in the Line Reactance or Conductor Ratings modules.

Field Name2 is used by those modules to determine the numbers and sizes of the core and outer strands. The Name2 field needs to be in one of these two formats:

- \( x/y/z \) where \( x \) is the number of outer strands, \\
  \( y \) is the number of core strands, \\
  \( z \) is the strand diameter (same for core and outer)

- \( x/y + z/a \) where \( x \) is the number of outer strands, \\
  \( y \) is the outer strand diameter, \\
  \( z \) is the number of core strands, \\
  \( a \) is the core strand diameter

You can have further description after the above numbers; it is ignored by the two modules.

Correct examples are 30/7/3.00 AACSR/6201A and 54/4.75+19/2.85.

### 5.3 Species table

This database is used by the Pole strength calculator and contains details of timber species and typical pole manufacturing parameters. Property descriptions follow:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOR</td>
<td>Modulus of rupture (MPa)</td>
</tr>
<tr>
<td>MSF No W</td>
<td>Material strength factor, no wind load</td>
</tr>
<tr>
<td>MSF W</td>
<td>Material strength factor, wind load</td>
</tr>
<tr>
<td>( f_c ), ( f_b ), ( f_s ), ( \gamma_m ), ( \rho_c )</td>
<td>Timber properties described in AS7000:2010 section F, AS-1720.1 and AS1720.2</td>
</tr>
</tbody>
</table>
### Field name

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• $f_c$ - characteristic strength in compression parallel to grain</td>
</tr>
<tr>
<td>• $f_b$ - characteristic strength in bending</td>
</tr>
<tr>
<td>• $f_s$ - characteristic strength in shear</td>
</tr>
<tr>
<td>• $\gamma_t$ (Default values are average timber density based on all species of the corresponding grade in table 1, AS1720.2-2006)</td>
</tr>
<tr>
<td>• $\rho_c$ – material constant</td>
</tr>
</tbody>
</table>

### Diameter taper

Taper for section of pole between butt and nominal ground level. Reference only, not used in calculations.

### Mid taper

Taper for section of pole between nominal ground level and tip

---

### 5.4 Plant database

This database contains details of any plant that can be attached to a pole, eg transformers, reclosers, signs.

### Field name

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Attachment height/ offset – These two values give the position of the centre of balance of the equipment. Offset is the distance from the edge of the pole to the centre of balance of the plant. This value is added to the radius of the pole at the attachment height to determine the final position of centre of balance of the plant.</td>
</tr>
<tr>
<td>• Orientation – Corresponds to the direction of the face of the item</td>
</tr>
<tr>
<td>• Area face, side – Area in m²/ft² of the face and side. <em>Face and side</em> can be whichever side is most convenient as long as the dimensions and <em>Orientation</em> correspond.</td>
</tr>
</tbody>
</table>

---

### 5.5 Poles database

This database contains dimensions and strengths of poles. You can enter any type of pole that can be modelled as a strut (ie a single column rather than a tower comprised of multiple elements).
<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Length</td>
<td>Full length of pole from butt to tip</td>
<td>In metres or feet</td>
</tr>
<tr>
<td>Default Sinking</td>
<td>Sinking depth</td>
<td>In metres or feet</td>
</tr>
<tr>
<td>Default Height</td>
<td>Height of pole tip above ground. This will equal length - sinking depth</td>
<td>In metres or feet</td>
</tr>
<tr>
<td>Material</td>
<td>Eg wood, steel</td>
<td>For reference only</td>
</tr>
<tr>
<td>Weight</td>
<td>In kg or lbs</td>
<td>Used for assessing vertical load</td>
</tr>
<tr>
<td>Diameter: tip</td>
<td></td>
<td>In mm or inches</td>
</tr>
<tr>
<td>Diameter: tip transverse</td>
<td></td>
<td>In mm or inches. Used for rectangular poles only</td>
</tr>
<tr>
<td>Diameter average</td>
<td>Average above ground diameter.</td>
<td>In mm or inches.</td>
</tr>
<tr>
<td>Diameter: average transverse</td>
<td>Average size of pole side</td>
<td>In mm or inches.</td>
</tr>
<tr>
<td>Diameter: groundline</td>
<td></td>
<td>In mm or inches.</td>
</tr>
<tr>
<td>Diameter: groundline transverse</td>
<td></td>
<td>In mm or inches.</td>
</tr>
<tr>
<td>Diameter: butt</td>
<td></td>
<td>In mm or inches.</td>
</tr>
<tr>
<td>Diameter: butt transverse</td>
<td></td>
<td>In mm or inches.</td>
</tr>
<tr>
<td>Strength: no wind</td>
<td>Maximum tip capacity of pole for sustained/everyday load conditions</td>
<td></td>
</tr>
<tr>
<td>Strength: wind 1</td>
<td>Maximum tip capacity of pole for short duration wind load conditions</td>
<td>Used for working stress calculations only</td>
</tr>
<tr>
<td>Strength: wind 2</td>
<td>Allows for a second wind loading in calculations</td>
<td>Used for working stress calculations only</td>
</tr>
</tbody>
</table>
## Field name | Description | Comment
--- | --- | ---
Strength: ultimate | Ultimate strength capacity of pole (usually provided by pole manufacturer) | Used for limit state calculations only
Strength: vertical | Vertical strength capacity | Enter 0 or leave blank to prevent the program performing a vertical strength check
Strength: transverse | Ultimate limit Strength of pole on pole side (cross line) | For rectangular poles only
Remarks | Remarks | |
Round Pole | Tick if a round pole | |

See sections 17 to 20 for instructions to set up the poles database for specific types of projects.

### 5.5.1 Temp poles databases

Poles saved in the Pole Strength module using the Temporary selection as put into the Temp Poles database. The data format is the same as the main Poles database.

### 5.6 Constructions database

Constructions model the cross-arms or insulators that conductors are attached to on poles. The benefit of using constructions is that spacings (clearances) and tiploads are more precise. The drawback is that it is more work to create a profile!

Fields specific to the Constructions database are:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachments</td>
<td>Click the button on the row to open an interface where you can enter or edit attachment points. See section 5.6.1 for details.</td>
</tr>
<tr>
<td>Default distance below tip</td>
<td>Default distance below tip to attach the king bolt of this construction</td>
</tr>
<tr>
<td>Default distance below supercircuit</td>
<td>(not used)</td>
</tr>
<tr>
<td>Default attachment height</td>
<td>(not used)</td>
</tr>
<tr>
<td>Voltage</td>
<td>Line to line and Line to ground voltages. Line to ground</td>
</tr>
<tr>
<td>Field name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>voltage is used to check and filter constructions when attaching conductors to them in the Profile module.</td>
</tr>
<tr>
<td>Reference file</td>
<td>A file that contains reference information or a photo etc. This file is not stored with the database; the entry in the database is just a file name. To edit the filename double click in the cell. If the database has not been unlocked (ie it is still in read-only mode) the file will be displayed in its default application when you double click in the cell.</td>
</tr>
</tbody>
</table>

**5.6.1 Constructions attachments into database**

Click the button in the Attachments column in the database for the row you are working on – circled in figure 5.

![Database table](image)

*Figure 5: Attachments button*

This opens a window where you can enter and edit attachment data. Figure 6.
The X coordinate is a horizontal distance relative to the kingbolt, the Y coordinate is vertical. The reference system is important as all constructions in the profile are assumed to have the same orientation. See figure 7. Decide when you are entering dimensions which way will be “left” for your constructions – that will be negative X values.

When conductors are attached to the constructions the wires are mapped to the corresponding attachment points in order as entered into the database.

Constructions are described by the position of the conductor attachment points relative
to a reference point (such as the king bolt). Figures 8 and 9 are examples.

You need to enter one data row into the table for each attachment point. The following two examples both have 3 attachment points.

Figure 8: Construction dimensions

Figure 9: Constructions dimensions
King bolt is 150mm below pole tip, attachments from left to right:

<table>
<thead>
<tr>
<th>Attachment</th>
<th>X dimension (horizontal)</th>
<th>Y dimension (vertical)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment 1</td>
<td>-0.55</td>
<td>0.12</td>
</tr>
<tr>
<td>Attachment 2</td>
<td>0</td>
<td>0.6</td>
</tr>
<tr>
<td>Attachment 3</td>
<td>0.55</td>
<td>0.12</td>
</tr>
</tbody>
</table>

King bolt is 150mm below pole tip, attachments:

<table>
<thead>
<tr>
<th>Attachment</th>
<th>X dimension (horizontal)</th>
<th>Y dimension (vertical)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment 1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Attachment 2</td>
<td>0</td>
<td>-0.85</td>
</tr>
<tr>
<td>Attachment 3</td>
<td>0</td>
<td>-1.65</td>
</tr>
</tbody>
</table>

5.6.2 Notes about constructions

1. All dimensions are in metres or feet

2. The order you insert attachment points into the database is important. When attaching conductors to constructions on pole, it is assumed the wire runs between corresponding attachment points, eg point 1 on one pole to point 1 on the next pole. This default order can be changed in the profile segment window.

5.7 Stays database

You can specify properties of stay constructions in this table. Each record has:

- Code, unique
- Description (optional)
- Strength, in kN or lbs. This will be the limiting strength of the stay construction, which may be the cable, insulators or anchor or other component.
- Set name
• Wire code. This is a code from the Conductor database for the wire used in this stay construction. The properties of the wire are used only if two stays are installed on a pole in a 2D arrangement ie the stays are in the same vertical plane.

5.7.1 How to use

You can select Stay types in the tipload or profile modules. The benefit of selecting a stay is the percentage loaded of the stay is shown when tiploads are calculated. The option setting Tiploads > Stay wire strength reduction factor is applied to the strength capacity from the database.

5.8 Wire files database (US version)

The program contains data for almost 1700 US conductors for use in the sag-tension module. The data should not be edited unless you know what you are doing as correct parameters are required for accurate calculations.

PowerMation takes no responsibility for the accuracy of the data. There may be some conductors with similar names. The user is responsible to confirm the accuracy of data they wish to use.

5.9 Adding a new record to a database

New records are added to all tables in the same way. The data required for a record will vary between tables.

When the database interface is opened the tables are in read-only mode to prevent accidental editing. To add a new record follow these steps:

1. select the desired table from the dropdown list

2. put the table in editable mode by clicking Unlock at the top of the window (figure 10). The word Unlock will change to Lock indicating the table is now editable.

3. On clicking Unlock a new row will appear at the bottom of the grid. This is where you enter a new record. It has a star in the left grey column.

4. Once you start typing in the new row an additional row will be created with an...
5. Enter data into all the required columns and into the optional columns as desired. See the table descriptions in above sections for information on which columns are required and which are optional.

6. When you have finished entering data click ENTER to exit from line-editing mode. You can continue entering other new records or edit existing records as needed.

7. When you have completed all your data entry you can click Lock to exit edit mode or just close the window.

8. You are asked *Do you want to save changes?* Select YES to retain the changes to the database.

9. You will be prompted to exit and restart Poles ‘n’ Wires to be able to use the new data.

### 5.10 Import a pole data file

If you have purchased a pole data set from PowerMation you can import this data into the database.

- Click *File>Databases>Import pole data file* (on the main window) to open a file selection window. Browse to the pole data file and click Open. The data will be imported and a brief summary shown.

- You will need to close and restart Poles ‘n’ Wires to make the changes available for use.

### 5.11 Export working set

This function allows you to select records from the databases that are part of a working set (Set name property in the databases) and export a file that can be imported into a version 6 database.

Select the database and set name (all set names in all tables are listed). If there are any matching records you are asked for a filename and the data is saved. You can import this data into version 6 using the Import function under *Functions>Databases* on the main window.

This function is provided only for backwards compatibility purposes.
6 Sag Tension Temperature Module

This is a module that allows you to examine the loads and sags for one span under various conditions.

The individual results in this module are calculated in the same way as the sags and tensions shown in the tipload and profile modules.

6.1 Data to enter

- Conductor code
- Span length
- Vertical. This is the vertical height difference in attachment points. A positive number means the attachment point on the “right” pole (see figure 11) is above the “left” pole attachment point.
- Tensions – Enter at box (A) either %CBL, a value in kN or pounds, or a Table
Table values: Some utilities use their own tables or charts that have a relationship to tension in kN. The table provided with Poles ‘n’ Wires is for the Energex tables. Ask PowerMation for details if you require further information.

- Load conditions. Enter temperatures, wind loads and select ice loading as needed. You can create up to 3 load conditions that will be evaluated simultaneously, as well as the blowout case.

- MES (mean equivalent span or Ruling span). The theoretical representative span length. If you double-click in this text box the MES calculator module opens allowing you to calculate the MES from span lengths. Click Return or close the window and the MES is entered in the text box.

The Actual tension calculated is the horizontal tension on a pole due to a single wire with characteristics as entered in the module.

### 6.2 Calculate sag from tension

If you know the sag (eg of an existing span) you can derive the stringing tension. Enter the sag value at box (B). The stringing tension calculated is shown in the results grid.

#### 6.2.1 Link to sag calculation module

Under the Calculate Tension from Sag frame is a button that opens the Sag from measurements function (section 22). Upon closing that function the calculated value for mid-span sag is entered into the sag-tension window.

### 6.3 Results

The grid at the bottom shows results.

- Vertical loads. A positive value means a downloads load, a negative value means an uplift load.

- Transverse load. Due to wind blowing sideways on the conductor, assumed to be at 90°.
7 Sag Tension Module – US version

When options are set as shown below the US version sag tension module is displayed when Other modules>Sag tension is clicked.

The US module uses the stress-strain approach taken by other software commonly used in USA for line design.

Select the conductor using the Material and/or conductor dropdowns. The default conductors available are derived from wire files (from the PLS CADD website).

Note – PowerMation can take no responsibility for the accuracy or correctness of data in these wire files. The user should always confirm that the conductor they select is appropriate for the application and that the properties are correct.

Enter Ruling Span length and Inclination (vertical height – only meaningful for a single span).
7.1 Load case tab

See figure 12. The program loads any previously created load cases from the Loadings sub-directory in the data directory. You can edit any of the values that are shown.

The lines in the top table are limits, the bottom table shows additional temperature/loadings to be displayed in the calculation results.

Any cells left blank are assumed to be zero.

![Load case tab](image)

**Figure 12: Load case tab**

7.1.1 Save loadings

This functions let you create any new loadings you want to have available for subsequent calculations. After editing loadings or temperature conditions, click Save Loadings and enter a file name. If you save the file into the default location (the loadings sub-directory under the data directory, the loading will be available in the dropdown.

7.2 Stringing table tab

See figure 13. Generate excel stringing tables using the calculated results as the ruling
span tensions. Enter the range of span lengths and select options on the right side of the window. Click Browse to enter a file save location and filename. Then click Generate stringing table.

Figure 13: Stringing table tab

### 7.3 Conductor Properties tab

A table shows all parameters for the selected conductor. This is read-only.

You can use the conductor selected on the first tab as a messenger (catenary) cable that has other non-supporting wires attached. Tick to use as messenger and enter the number of additional cables and the diameter (inches) and weight (lb/ft) of each.
Select to apply the fixed load factor (k) to the messenger only or to all wires.

Sag10 version 2 appears to apply the k factor differently to version 4 so you can select the version for compatibility as desired. Use version 4 unless you particularly wish to have compatibility with version 2.

At the moment you cannot select to apply load limits to after installation of the non-supporting wires.

7.4 Trial version

In Trial mode the following restrictions apply:

- only one conductor is available
- you cannot generate a PDF report or stringing tables
- some values are randomly removed from the results table
8 Tipload Module

Before using this module you need to set the load combinations in Options. Examples of settings (metric units) are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Load combinations</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Working stress – no wind</td>
</tr>
<tr>
<td>Wind on pole</td>
<td>0</td>
</tr>
<tr>
<td>Wind on conductors</td>
<td>0</td>
</tr>
<tr>
<td>Ft factor</td>
<td>1</td>
</tr>
<tr>
<td>Wn factor</td>
<td>1</td>
</tr>
<tr>
<td>Gs factor</td>
<td>1</td>
</tr>
<tr>
<td>Gc factor</td>
<td>1</td>
</tr>
</tbody>
</table>

Further details of set-up requirements are in sections 17 and 18. You can open tipload project files saved from versions 6 or 7 but can save files only in version 7 format.

8.1 Creating a new tipload project

8.1.1 Open the tipload module

The following steps assume you have already set up options as needed.

8.1.2 Enter pole details.

You can enter these manually or select from a pole type if they are available in the pole database. If you select a pole from the database results show the percentage loading on the pole based on the strength defined in the database for each load combination.

- Orientation. This is used only with reference to rectangular poles. This is the direction of the face of the pole.
- Average diameter. Average above ground diameter is used for wind loading.
- Width, face and side. When using a rectangular pole these dimensions are used for wind loading rather than average diameter.
• Point of contra flexure. Enter a value here to use a point of contra flexure other than ground level. The default value is 0. See section 4.4.4 in Options for a description of valid values.

If you change the pole height and there are conductors attached you are asked if you want to change the attachment heights to correspond. If yes, the circuit heights are changed so the distance below tip is the same as before the pole height was changed.

8.1.3 Filter Poles databases

If you have chosen a “default working set” in Options the list of Poles available in the dropdown is filtered on the basis of the setting. If you have made no Option setting all poles are listed. If you have saved poles assessed in the Pole Strength module these poles can also be filtered. You can change the filter by double-clicking on the word Pole Type (green background). This will open a window showing all the Working Set names, from which you can select one, or All.

8.1.4 Enter circuit details.

Column details are:

• Include. Tick to include this circuit in the calculation. By default this is ticked,
but you can use it to model tipload with all circuits and tipload after taking a circuit off the pole, without having to delete the information from the circuit grid.

- **Circuit ID.** Optional for metric users; a unique ID is required for US version.
- **Direction.** In degrees (increasing clockwise) relative to whatever zero is suitable for the project. All circuit directions and resultant tipload directions are relative to the same zero.
- **Conductor.** This contains an auto-complete feature. Double click in this cell to open the conductor search window. See section 12.
- **Number of conductors.** Note that bundled cable is counted as one conductor.
- **Attachment height.** If you double click in this cell a window will pop up showing pole height. Enter a value in distance below tip and the attachment height will be calculated. Click Use to enter this value into the circuit details, otherwise click Cancel. You may not see the updated value until that cell is refreshed by clicking somewhere else in the grid.
- **Span length**
- **MES.** Mean equivalent span (Ruling span). Defaults to span length. If you double-click in this cell the MES calculator module opens allowing you to calculate the MES from span lengths. Click Return or close the window and the MES is entered in the cell.
- **Tension type.** Select from the dropdown. Default is set in Options.
- **Tension.** Value that corresponds to the tension type. For example to string the cable at 22% CBL select %CBL in the tension type column and enter 22 in the Tension column.
- **Vertical height.** Height difference between this attachment point and the attachment point at the other end of the span. Positive numbers mean the adjacent attachment point is higher. This distance is relative to the two attachment points not relative to the ground. Defaults to 0.
- **Section length.** The length of the strain section this span is part of. Used when applying Span reduction (gust response) factors. Defaults to span length.
- **Ice loading factor.** Use this to model a partial ice load on this span. 100% is represented by 1 going down to 0 for 0%. For example 70% loaded will be 0.7.
you do not have an ice load this value is ignored.

8.1.5 Load combinations

Select the load combinations you need to assess for this project. Pole Strength Reduction Factor for each load is taken from defaults in Options but can be edited.

8.1.6 Stays

If you have one or two stays on this pole enter the details. Tick “Include” to include or exclude either stay in a calculation.

You can optionally select a stay wire from the Stay database. If you do this the tipload results include a percentage loaded on that stay wire.

The stay wire code, pole class (unless you have selected a pole from the database at the Pole Type dropdown) and groundline diameter are needed if the stays are both in the same plane, or close to it.

8.1.7 Plant

Select up to two plant items to attach to the pole. Tick “Include” to include or exclude the plant items from the calculation.

**Direction** is the direction of the face of the plant item.

Plant item 1 allows you to enter a “fixed load”. This is a load defined by direction, magnitude and attachment height that can model for example a stay load transferred from a line pole to a bollard pole. The fixed load is applied to all load combinations being calculated.

8.1.8 Foundation

You may want to compare the tipload with the strength of the foundation you are using. Three values are required:

- soil type (see the Soil types database for information)
- footing diameter (see section 23.1)
- footing factor (see section 23.1)

The calculation is performed using the same approach as the Pole Foundation module (section 23) and if the tipload exceeds the foundation strength for any of the load combinations you are using a warning is shown.
8.1.9 Global settings

General information relevant to the calculation.

8.1.10 Click Calculate

Results are displayed numerically and with a polar diagram. The diagram is a plan view showing the direction of circuits and resultant loads. If you have used a pole from the database the percentage loading is also shown.

For each load case the following results are shown:

<table>
<thead>
<tr>
<th>Resultant load</th>
<th>The worst case tipload on the pole. Tiploads are calculated for each wind direction from 0° to 360°, stepping by the interval set in Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direction</td>
<td>Direction of the worst case tipload</td>
</tr>
<tr>
<td>Wind direction</td>
<td>Direction of wind that leads to the worst case tipload. For a no-wind load case this value is not applicable</td>
</tr>
<tr>
<td>Stay loads</td>
<td>If there are stays on the pole the tension in the stay wire (allowing for stay attachment height and angle to ground) is shown</td>
</tr>
<tr>
<td>Vertical load</td>
<td>Total vertical load on pole due to conductors, stays and pole self-weight</td>
</tr>
<tr>
<td>Over-tension limit circuit/s</td>
<td>If the tension in any span under the load conditions exceeds the limit set in Options this is indicated, identifying the circuit by conductor code, attachment height and direction</td>
</tr>
</tbody>
</table>

For rectangular poles these additional results are shown:

<p>| Load - face | The worst case tipload on the pole resolved relative to the direction of the pole face |
| Load - side | The worst case tipload on the pole resolved relative to the direction of the pole side |
| Worst load on face | Largest load that the face of the pole sustains due to wind load from any direction. This will not necessarily be the same load as for the worst case tipload |
| Worst load on As above, for the pole side |</p>
<table>
<thead>
<tr>
<th>Load - face</th>
<th>The worst case tipload on the pole resolved relative to the direction of the pole face</th>
</tr>
</thead>
<tbody>
<tr>
<td>side</td>
<td>Direction of wind that leads to the largest load on face/side of pole. For a no wind load case this value is irrelevant</td>
</tr>
</tbody>
</table>

### 8.2 Print a report

Print function is under the File menu. The report will open in the default PDF viewer. The report shows any Span Reduction Factor used in the calculation for each circuit.

#### 8.2.1 Kingbolt loadings

A table shows worse case loading at each attachment height incorporating number of conductors and load factors. The values represent the load on the kingbolt at each crossarm. It is assumed that any circuits with the same attachment height on the pole are on the same crossarm.

### 8.3 Save

Under the File menu. Saves the file with an extension pnwx to indicate it is a version 7 file. You cannot save the project as a version 6 file.

### 8.4 Open or Merge

Under the File menu. You can open version 6 or version 7 tipload files. The existing data on the screen is removed before the data from the file is loaded.

When you select *Merge tipload file* the existing data will be retained and the circuit data from a second file will be inserted. Pole, stay and plant data from the second file will be ignored. No checking for compatibility is done on the data from the second file. The Merge function can be used to combine two tipload files created for example if you have two profiles that intersect at a common pole. In each profile save the tipload data for the common pole, then open one file first in the tipload module and merge the second file. The total tipload on the common pole will be calculated.
8.5 Grid functions

Select a row by left-clinking in the left (grey) column. Right click to bring up a menu. You can copy or mirror the row. Copy enters a new row at the bottom of the grid with the same details as the highlighted circuit, mirror does the same but reverses the direction by 180°.

Show All Rows and Show only Included Rows allows you to filter the data rows to make it easier to see what circuits are included in the calculation.

8.6 Resultants

8.6.1 Full report summary

Click the Full Report menu item to display the unfactored contributions to the tipload from each component of the pole, eg wind on pole, conductor tension.

A new window will open (figure 14). Select the load combination you want to examine from the dropdown.

The table displays each component in columns. The unfactored contribution for each direction is listed. Wind direction is reported in standard meteorological convention, i.e. the direction the wind is coming from in degrees clockwise from the zero reference direction, stepping by the interval set in Options. The worst case (ie the tipload result) is shown by bold typeface.

This table can be copied to a spreadsheet by clicking CTRL A and CTRL C, then pasting into a new spreadsheet document.

8.6.2 Wind angles

This report shows the relative magnitude of the tipload as a function of the direction wind is coming from, that is, when the wind is from a certain direction, what is the

magnitude of the tipload. You can select the load case to display. When the mouse is moved over the chart the magnitude of the tipload is shown in the top right corner of the window.

Figure 14: Tipload full report

8.7 Combined bending/compression check

AS7000:2016 Section F5.4 gives an equation for combined bending and compression. Vertical and horizontal forces on a pole affect each other and the combined check gives a report of this effect.

The equation is

$$\left( \frac{M^*}{\Omega_M} \right) + \left( \frac{N^*_c}{\Omega_{N_c}} \right) \leq 1$$

the symbols meaning:

- $\Omega$ strength reduction factor
- $M$ calculated pole bending capacity
- $M^*$ tipload acting on pole
- $N_c$ strength capacity in axial compression
- $N^*_c$ vertical load on pole including self-weight

The outcome of this check is that a pole may “pass” in either bending strength or compression but may not pass the combined check.

If you are not required to do a combined check you can make Poles ‘n’ Wires omit the check by setting to zero the compressive (vertical) strength of the pole you are using from the Poles database.
8.8 Interpreting results

Poles ‘n’ Wires applies wind from a range of directions between 0 and 360, in steps of the size nominated in Options. The worst case results are noted and displayed. In some cases there will be more than one worst case direction.

The direction for wind loading results may differ from that for the no wind condition. Also, it is possible for there to be more than one worst-case wind direction, although only one direction will be displayed.

When the wind blows in a direction perpendicular to the conductor the conductor tension is at a maximum. The resultant load on the pole for that conductor is the vector sum of the longitudinal load applied by the conductor and the small transverse wind loading on the conductor, acting at right angles to it. Subject to option settings the wind load on each conductor may be reduced allowing for the difference in direction between the wind and the conductor. The loads due to each conductor and any wind load on the pole itself are vectorially added together giving the resultant tipload for that wind direction.

8.9 Import from spreadsheet

Instead of manually entering data into the tipload window you can import the circuits and stay information from a spreadsheet.

The columns in the spreadsheet generally mirror the data in the tipload grid. To define the circuit tensions use one of these methods; you can use a different method for each circuit:

1. column J for %CBL
2. column K for tension in kN or lbs
3. column L for a table value
4. column N to define the midspan sag, from which tension is calculated
5. columns O-S to define field measurements from which tension is calculated

<table>
<thead>
<tr>
<th>Column</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>Attachment height on pole 1</td>
</tr>
<tr>
<td>Column</td>
<td>Use</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>O</td>
<td>Attachment height on pole 2</td>
</tr>
<tr>
<td>P</td>
<td>Midspan measured height</td>
</tr>
<tr>
<td>Q</td>
<td>Distance from pole 1 where midspan height is taken</td>
</tr>
<tr>
<td>R</td>
<td>Ground level offset at chainage Q (negative for a dip, positive for a rise)</td>
</tr>
</tbody>
</table>

When calculating tension from sag (options 4 and 5) you need to use column M to define what actual conductor temperature corresponds to the sag.

A stay is defined by entering Y in column C. Column E gives the angle between the stay and the ground. Only columns A, B, C, E and F are used for a stay.
9 Profile Module

Click the Profile button in the main window to open the profile module. The module opens as a blank window. You can create a new profile or open an existing profile.

You can open profiles created by the latest version 6 or profiles created by version 7.

9.1 New Profile

Click the New menu item under the File menu. On clicking New you are asked for information about the new profile.

- groundline type
- project name
- remarks

You now have a blank profile.

9.2 Steps in creating a profile - overview

A profile has 3 elements, the ground line, poles and conductors.

9.2.1 Ground line

You can enter the groundline by hand or import it from a file (several file formats are acceptable). Manual entries give a profile that is in a straight line (ie no deviations at poles). If you want to include deviations in the profile you will need to create a spreadsheet and import it.

The profile assumes flat ground so if you are working in flat terrain you do not need to enter a groundline at all.

The groundline is considered as the line of the conductors. If you are using surveying information you will need to ensure the data was collected correctly – under the line of the conductors.

The groundline can be specified in one of 3 ways:

- chainage/level: Horizontal and vertical distance along the profile
- distance along slope/angle: A distance along the slope of the ground and an elevation in degrees (positive is a slope upwards)
9.2.2 Poles

Poles are entered manually or can be included in a groundline imported from a spreadsheet. The minimum information required for each pole is chainage (distance from the start of the profile) and height (height of the pole tip above ground). Poles are assumed to rotate about the groundline, the common assumption in distribution lines particularly for wood poles.

9.2.3 Conductors

Conductors are entered into the profile as a “segment”. A segment holds all the properties associated with a strain section. Segments can be one span or many spans and are dealt with as one entity.

9.2.4 Assessment of profile

After you have entered all the necessary information you can check clearances, tip loads, uplift and generate PDF or DXF reports.

You will typically need to check the following conditions to ensure that the line design meets clearance requirements:

a) maximum (hot) design temperature (eg 75°C). Clearances from ground for the lowest circuit. Be sure that the circuit curve is not below the minimum clearance height.

b) uplift (cold, eg 0°C) condition. Problems can occur for poles in a hollow or on a steep slope or where there is a significant difference in attachment heights. Uplift is evident when the lowest point of the circuit span is at the pole at the low end rather than a point within the circuit span, ie the span rises immediately adjacent to the pole instead of sagging down. If uplift exists, you will need to use a strain construction or similar, or else alter pole position, increase pole height or reduce conductor tension.

c) intercircuit clearances. Typically you will need to check using hot temperature (eg 75°C) on top circuit, cool temperature (eg 5°C) for sub-circuit.
9.3 Ground line – manual entry

To enter a ground line manually, click Entities>Groundline. This opens a table where you can enter details. After entering the data click Refresh to redraw the profile. The groundline grid can be left open or closed.

Select the type of ground data you have. You cannot change the ground line type (eg from chainage/level to chainage/slope) after you have commenced entering data.

Only the first two columns are required. Other columns will be completed with data from option settings.

When using chainage/level the ground line points are always sorted by chainage so if you enter them out of order it will be resorted.

When using distance/slope or chainage/slope data, points are used in the order you add them. If you missed a point and want to add it in, you cannot just add it at the end – it needs to be in the correct position. You can insert a line by selecting a line (click in the grey row header) and right click and click Insert before or Insert after. The highlighted line will be duplicated, you can then edit the new line.

9.4 Ground line - Import a file

There are several types of data that can be loaded into the profiler from files. Descriptions of the file format are in section 10.

9.4.1 Load the file

Click on the Entities menu then click Groundline and the Import menu will show. Click the Import menu and you will see a list of the available data types that can be used (figure 15). Double click the one you want to use and you will see the standard Windows Open file dialog. Browse to the file and click Open. If the file is formatted correctly the profile data will be imported and the profile drawn.
9.5 Poles

Access the pole data by clicking Entities>Poles. You can then go to the pole summary window or insert a single pole or an array of poles.

9.6 Pole Summary

This shows a table where you can enter data about the poles in the profile. Minimum data is pole ID (must be unique), distance (relative to start) and height above ground of the pole top.

Length and sinking depth are optional. If they are omitted length will be made the same as pole height and sinking depth will be set to zero.

If wind load on poles is included in tipload calculations enter average above ground diameter in mm or inches, otherwise zero is assumed and there will be no wind load on the pole.

When the pole height is altered by manually changing height, length or sinking depth or changing the pole Type, you are asked if you want to adjust the conductor attachment heights as well. If you select yes, the conductors (and constructions if any) are moved so they are at the same distance below pole tip as before you altered the pole height.

9.6.1 Chainage

Distance from the start of the profile. A level distance, this distance is along the line of the profile including deviations.
Double-clicking in the Chainage cell for a pole opens a window allowing you to select an existing pole in the profile and set an offset distance from that pole for the current pole. A negative offset means the pole will be inserted to the left (lower chainage) of the existing pole.

9.6.2 Height above ground

Of the top of the pole. If you don’t enter pole length, the length will be taken as the same as the pole top with sinking depth of 0.

9.6.3 Other columns

Other columns can be left blank and they will be completed by defaults taken from Options.

9.6.4 Pole type

Instead of entering pole height, etc you can select a pole from the pole database. Select from the drop-down and the details will be entered automatically. Sinking depth can be edited to allow for a non-standard depth. The pole height (tip height above ground level) will be recalculated.

9.7 Pole details tab

Use this tab to enter a stay, associate a file (eg photo) with the pole and view tipload calculations. Save the pole data for tipload calculation purposes by clicking Save tipload data. You can move through the poles using the arrow buttons, or click the drop-down next to Go To to move directly to the selected pole.

Tipload calculations are performed using the load combinations previously selected in the tipload module.

You can edit the easting/northing of a pole. You will be asked for confirmation that you
want to do that. If you have entered a groundline through one of the importing functions you need to understand the consequences of moving a pole off that groundline.

Poles are assigned a default colour (that is suitable against the black or white drawing background) but you may choose your own colour. Click the colour pen in the bottom margin to select a colour.

9.8 Tipload calculations

In version 6 you need to use the right click>show pole forces function to perform a tipload calculation (working stress or limit state) on a pole in the profile. Version 7 operates differently. Tiploads are calculated without user intervention and are displayed in the Entities>poles summary>details window.

However you need to set up the program first so the desired tiploads will be shown.

1. Go to options and create the load cases as needed.
   - If you have imported your options from a version 6 installation the settings should all be there but do check them

2. Save and close options

3. Open the tipload module. All available load cases will be listed (figure 16)

4. Tick the load cases you want to use for this project. The selections will be retained until you change them again.

5. Close the tipload module

6. Open the profile module and create your profile

7. The load case selection in points 3 and 4 above can also be made in the profile module under the menu item Entities>Poles>Select load cases.

8. Go to Entities>Poles>Poles summary>details and you will see the tiploads (figure 17)
The above approach will be suitable for most profiles but there are some specific situations where you will need to manually adjust the tiploads, for example:

- if you have entered the groundline manually but there is a deviation at the pole (i.e., the circuits are not 180° apart)
- if you need to use 2 stays on the pole (in the profile you can enter only 1 stay)
- if you want to put a second plant item on the pole (in the profile you can enter only one plant item)

9.8.1 Open pole in tipload module

Click this button to transfer all the data for this pole to the tipload module. Edit the data as needed. To preserve these manual changes click “Save data to profile”. When you save the data the letter T is displayed at the top of the pole in the profile to indicate the tipload has been externally modified.

If you don't click “Save data to profile” any edits are lost.

You can also save the tipload project as a normal tipload project using the Save function in the tipload module, but the data is not preserved within the profile.
9.8.2 Reset

This causes the manual edits you have made to the tipload for this pole to be lost and the tipload is calculated just from the data within the profile.

9.8.3 Save tipload data

Opens a dialogue window where you can save the pole tipload as a tipload file suitable to open in the tipload module.

9.9 Pole additions

9.9.1 Conductors

All conductors attached to the pole are shown, displayed by segment and attachment height. The attachment height can be edited.

9.9.2 Stays tab

Add a stay to the pole by entering its details. You can retain the details of the stay and toggle the *Pole is stayed* value to see the effect of the stay.

You can add only one stay to a pole through the profile. If you need to use two stays save the tipload data, open the saved file separately in the tipload module and add the second stay.

- Angle to ground. the angle between ground and the stay
- Direction. relative to the same coordinate system as the rest of the profile.

9.9.3 Constructions tab

Use this grid to add constructions from the database to poles as required. See figure 18.
• Attachment height. Height above ground level

• Construction. Select from the dropdown. All constructions in the database are listed.

• Segment. When conductors have been attached this value shows which conductor segment is using this construction. (read only)

• Label. An optional label for your own reference.

• Voltage. Line to ground voltage from the database entry of this construction (read only)

• Description. A unique description you will use when attaching conductors to the constructions. (read only)

• Apply spacing rules. If you have defined a construction rules spacing file in Options (see section 4.4.9) click this button to apply the rules to the selected constructions for this pole.

When the profile is redrawn the constructions are shown as grey horizontal lines on the poles. The attachment heights used are the king bolt position (the attachment height in the constructions grid) added to the attachment position relative to the king bolt.

9.9.4 Plant

Add a plant item to the pole. Default values for attachment height and orientation are
inserted from the database; these can be edited. A blue P is displayed above the pole in
the profile window to indicate the presence of the plant item. The plant item is taken
into account in the tipload calculation for the pole.

9.9.5 Loads
This tab displays vertical loads on the pole due to conductors, calculated for the tem-
perature set for Uplift in Options for one conductor. A positive value is an uplift load.
The segment ID and attachment height is shown, and whether the circuit goes to the
left or right of the pole (as plotted in the Profiler window).

9.9.6 Refresh
After entering or editing pole details you may need to click Refresh on the main win-
dow to redraw the profile.

9.10 Insert a pole
You can insert a pole at a location in the profile by using the menu item
Entities>Poles>Click and drop pole. After clicking this menu item click the mouse at
the chainage in the profile where you want to insert the pole. A window will pop up
showing the selected chainage and you can enter the pole properties. Click Apply to in-
sert the pole, otherwise Cancel.

If you double-click in the Chainage text box a window opens allowing you to select an
eexisting pole in the profile and set an offset distance from that pole for the new pole. A
negative offset means the new pole will be inserted to the left (lower chainage) of the
existing pole.

9.11 Insert a pole array
This function allows you to enter a number of the same type of poles at one time. The
pole array window is shown in figure 19. Enter required details and click Process to
enter the array into the profile, or click Cancel.

9.11.1 Array details
- Starting chainage. Enter the chainage of the first pole in the array.
• Spacing. The distance between the poles. You can subsequently edit the pole

chainages if they are not all exactly spaced equally.

• Number of poles. There is no limit on how many poles you enter.

• ID prefix. Poles need an ID and for the array you can set the prefix. For example if you want to designate poles as P1, P2 etc enter P in the ID prefix box.

• Starting number. For the array. You can use 1 or start the count where it is convenient. The number will be incremented for each pole and combined with the ID prefix to give unique pole IDs.

9.11.2 Pole details

Enter at least the pole height. If length and sinking depth are blank length will be made equal to height and sinking depth made zero.

Alternatively click the Pole Type radio button and select a type from the database.

9.12 Import a set of pole data

Instead of entering poles individually in the pole grid, you can create a spreadsheet with the data and import it. Poles can be imported with a groundline (see section 10) but that process always creates a new profile. This function allows you to insert poles into the profile already open.
To access the import poles function, right click on the poles grid and click on the popup menu item, Import Poles. Browse to the excel file. The required file format is shown below.

You can also import an excel file that was created previously through the Export poles function (section 9.13).

9.12.1 Data format

Figure 20 shows the required format of the spreadsheet.

- Data is on the first sheet in the file
- first row is column headers
- 5 columns are required:
  - pole ID (unique)
  - height above ground
  - length
  - sinking depth
  - span length, distance between each pair of poles. In the example in figure 20 the distance between poles 20 and 21 is 88; between poles 21 and 22 is 82.
  - Units for lengths are metres or feet
- Note that the last line will not have a span length.

9.13 Export poles

If you need to save the poles in the profile to use again you can export the poles to an excel file. This file can be re-imported using the import poles function.

9.14 Conductors

In the profile conductors are entered by creating Segments. A segment stores all prop-
properties describing a strain section. Click Entities>Segments to open the segments window. Initially there are no segments in the profile so you will need to create a new segment.

**9.14.1 New segment**

1. Click the yellow + button (bottom of window) to add a new segment.
2. Edit the defaults as needed including entering a conductor if there is no default
3. Click the save button to save
4. Repeat steps 1-3 to add more segments
5. The default label for the segment is SSx, x being the next number in order. You can change the label to anything suitable provided it is unique.

**9.14.2 Edit an existing segment**

Use the scroll arrows at the bottom of the window to move through the segments in the profile. Edit any segment by changing values shown, then click Save to retain the changes. You can also use the menu dropdown next to “Go to:” to select a segment to view.

**9.14.3 Existing segments with new intermediate poles**

When new poles are added into a profile that already has segments at those pole locations, when the existing segments are opened, by default these new poles are also attached to the segments. This may not be what you want so you may need to untick the Include columns for these new poles. You may also need to adjust the attachment heights.
9.14.4 Select poles

Start the pole selection by choosing the first and last poles in this segment. The left pole will always have a lower chainage than the right pole. After selecting the left pole all poles in the profile to the right of the selected left pole are loaded into the dropdown under “Finish Pole” (figure 21). After selecting the right pole all intermediate poles are loaded into the grid along with their chainage. By default all intermediate poles are selected for inclusion in this segment. Untick any poles you don’t want to attach this conductor to. The default attachment height is calculated based on the selection in the Attachment Details section. Attachment height can be edited.

![Figure 21: Pole selection grid](image)

9.14.5 Attachment height
The conductor attachment height is determined by using the selected option in the attachment details to the pole height above ground. Click the radio button to apply the desired option.

- Distance below tip. Subtracted from pole tip height. Entering a negative value here attaches the conductor above the pole (for example an earth wire on a riser).
- Distance below lowest circuit. The conductor is attached the entered distance below the lower existing conductor on the pole. If there are no conductors on a particular pole the conductor is attached as per the value in the second Distance below tip box (indicated by A in figure 22).
- Nominated height. The conductor is attached at the same height on all poles.

After applying the default attachment height you can manually edit any height in the pole grid.

9.14.6 Conductor

This text entry has an auto-complete feature. Start typing the conductor code and matching codes will be listed. Double click in the text box to display the Search conductor window (See section 12).

Number of conductors is used in calculating tiploads but does not affect the profile. Note that ABC (bundled) conductor is indicated by entering 1 in this box not 3 or 4.

9.14.7 Ruling span/Mean equivalent span

The ruling span of the segment can be specified in one of three ways.
1. Span lengths. This takes the span lengths between the selected poles and calculates the RS.

2. Specified. Use this option to enter the ruling span manually. In this way you can model the behaviour of a complete strain section without having to put all the poles in the profile.

   The MES calculator can be accessed within this window by clicking the button. When the calculator is closed the calculated MES is entered in the segment properties.

3. Independent. This option allows you to model a run of conductor that is fixed at each pole, such as pilot or broadband cable. Each span length is considered independently so the RS for each span is the same as the span length.

**9.14.8 Temperature conditions**

You can show up to 4 temperatures for each segment. The default values for label, temperature and colour are set in Options. You must include at least one condition. The default label and temperature can be edited. To change the colour double click the colour column of the temperature you are working on. Select the desired colour from the colour picker.

If one of the labels corresponds to load combination 7 in Options the data from that load is used in calculating the loaded conductor weight, used to calculate sags and tensions.

When the circuits are drawn in the profile, colour-coded labels are attached to each circuit showing the segment label and the circuit label with the format [segment]: [circuit]. These labels can be manually repositioned. To move a label click on the text then drag the text by the grip box. Click again to set the new position. When a label has been positioned by the user that label maintains its position relative to the left pole in the span and the attachment height of the circuit that the label is connected to.

**9.14.9 Temperature grid – stress-strain method**

If using the stress-strain method (set in Options) you use the temperature conditions grid differently. Instead of entering the temperature for each condition, enter the tension for the strain section for each load case you want to show in the profile, as calculated elsewhere. An example is shown in figure 23.
If one of the labels corresponds to load combination 7 in Options the data from that load is used in calculating the loaded conductor weight, used to calculate sags and tensions.

9.14.10 Tension

Each segment requires a tension. The default tension type is set in Options.

Select the desired tension type from the dropdown and enter the corresponding tension value in the text entry box next to the dropdown.

If you select “%span length” the sag is calculated as the entered percentage of the span length and the tension calculated accordingly. RS type is automatically set to Independent.

9.15 Segment functions

The Functions menu gives access to several additional functions.

9.15.1 Copy segment

Clicking this functions creates an exact copy of the current segment with the ID having the suffix “_copy” which you can then edit.

9.15.2 Split segment

After clicking this function you are presented with a list of the intermediate poles in the current segment. Select the pole you want as the new common pole between the
two segments. The current segment is split in two and the newly created segment is assigned an ID being the name of the original segment with the suffix “_copy”

9.15.3 Combine segments

On clicking this function the profile is examined for any segments that have a start or finish pole in common with the current segment, with the same conductor at the same tension and attachment height. A list is shown of any possibilities for combination. Select as desired and the two segments are combined. The ID of the left segment (left relative to the start of the profile) is used for the new combined segment and the right segment is removed.

9.16 Using constructions

The default way conductors are attached to the pole is using the attachment height value. This is the height all the wires in this segment are attached to the pole ignoring their offset from the pole (which does not affect vertical clearances or tipload calculations).

If you have created entries in the Construction database you can use these to attach the conductors to the poles. The construction is attached to the pole at the attachment height (usually be the king bolt), then the conductor attachment points defined in the database are used relative to that attachment height.

When using constructions the attachment height is locked – if you want to change the attachment height of the construction you need to do so in pole properties.

9.16.1 Attach conductors to a construction

After you have put constructions on the poles you can attach conductors to them. This is done as part of the process of creating a circuit segment.
Create a new segment as usual. Since there are constructions in the profile two new columns are visible in the pole table (figure 24). These are a tickbox to select to use constructions and a dropdown to select from any available constructions on each pole.

For each segment you must attach the conductor either to all poles directly without using constructions, or use constructions on all poles. When you tick in the Use Constructions column for any row all the boxes change to match.

After ticking Use constructions, select the construction you want to use on each pole for this segment from the dropdown lists. All constructions you have added to each pole is shown. If you have previously used a construction for another segment this new segment will also connect to the same construction.

You can filter the constructions that are available for this segment using the Voltage filter. Once you select a voltage only constructions of that voltage are displayed in the pole details grid. To show all constructions select ALL for voltage.

![Figure 24: Construction details](image)
The label for the constructions show the construction name from the database plus a unique number which corresponds to the construction details as added on to the pole. See the figure below. This allows you to match constructions particularly if you have more than one of the same construction on a pole.

Enter or edit other details for the segment as usual and click the Save button. The conductors are attached to the pole at the heights allowing for the spacing of the construction attachment points.

When using constructions the number of conductors is ignored (number of conductors is taken from the database) and the attachment height (which is of the kingbolt for each construction) is not editable. If you want to change the attachment height you will need to do so in the pole details.

When using constructions the Measure function shows the vertical height difference between selected circuits and also the distance allowing for the horizontal spacing due to cross-arm width.

### 9.16.2 Conductor mapping

“Conductor mapping” is a phrase we use to describe the process of working out which insulators on the two ends of a span are connected with a wire. The default mapping is determined by the order that the attachment points are entered into the database, i.e., the first point on each construction is joined together.

If you need to change this default mapping (for example when the line goes from a flat crossarm to a vertical construction around a corner) click the **Edit Constructions Attachment Point** button (figure 25) under the pole information grid. This opens a window where you can edit the mapping (figure 26).
Insulators are connected together as determined by reading across a line. In figure 26 insulator 1 on each pole is attached to the same wire. To rearrange the order of insulators that are connected together click and hold the cell you want to reposition and drag it up or down the column (a pole) to the new position then release the mouse. Figure 27 shows wire 1 now connected to insulator 1 on P1, insulator 2 on P2 and insulator 1 on P3. Wire 2 is connected to insulator 2 on P1, insulator 1 on P2 and insulator 2 on P3.

When you have finished click Save to retain the changes or cancel to leave the mapping.
9.17 Conectors - General notes

1. “Left” and “right” poles are referenced to the start of the profile irrespective of the actual physical direction the conductors are running. The left pole will always have a smaller chainage than the right pole.

2. Attachment heights for each segment are altered in the grid on the left of the window

3. You will need to click the Save button to retain any changes.

4. If you double click in the Code entry box a search window will open, so you can search for the code of the conductor you want to use (see section 12).

5. To delete a segment click the red cross in the bottom panel of the Segments window.

6. You can delete all conductors in the profile through the Entities > Conductors > Delete all segments function. You are asked to confirm before the deletion is done.

7. You can view a summary of all segments in the profile or all individual spans by going to Entities > Conductors and selecting Segment summary table or Spans summary table.

![Figure 28: Segment summaries](image)

9.17.1 Undo

Under the Entities menu there is an undo function. Click this to undo the most recent edit to the profile. There is a limit of about 20 steps you can revert. There is no Redo function.
9.17.2  Refresh

Changes to segments are reflected in the profile after you Save the segment.

9.18  Insert object

This function allows you to add objects to the profile such as a transmission line crossing the profile. The purpose is so you can measure clearance between the profile and the object.

Each object needs a unique ID, chainage and height above ground.

Objects are drawn as a circle with the ID next to it.

Objects can be selected as items for the Measure function (section 9.21).

9.19  Zoom

Use these controls to show different views – extents (the whole profile), zoom to a window (select by mouse), real time pan.

Set vertical scaling – to assist with viewing the profile on the screen you can scale up the view. Default is set in Options.

9.20  Planview

Under the Zoom menu is the menu item Plan View. Click this to open a new window showing the plan view of the profile. Poles are drawn with circuits attached showing the extent of blowout. Blowout is calculated from options set under Options>Sag Tension.

9.21  Measure function

This function allows you to measure between

- ground and circuit

Figure 29: Measure function result
To use the function:

1. Select the two items to measure clearance of, for example ground and a conductor. Once selected the items will be highlighted in blue. To change the selection hit ESC and reselect.

2. Click Functions>Measure

The result is shown in the right margin of the profile window (figure 29).

For ground-circuit and circuit-circuit the first result shows the spacing at the chainage where you selected (clicked on) the second item. The second result gives the closest approach of the two items.

For pole-circuit and object-circuit the clearance above the pole or object is shown. If the circuit is below the item, as often the case if the object represents a transmission line crossing, the clearance will be negative.

If a circuit you have clicked on is part of a segment that is attached to constructions on the poles and there is more than one wire at that same height you are presented with a list of wires. Details of the relative attachment positions on the poles at the end of the span are shown to allow you to identify the wires. Double click in the grey row header of the wire you wish to use for the Measure function and the window will close retaining your selection.

9.21.1 Measure at a chainage

The default action of the Measure function is to perform the calculation at the chainage selected by clicking the mouse. An alternative method allows you to enter an exact
chainage for the measurement. Access this method by holding the CTRL key when clicking the Measure menu item. A window will open asking you for a chainage. No checking is done to verify that the chainage you enter is valid for the measurement and an error message will show if it is not valid.

9.22 Uplift

Uplift is checked when the profile is refreshed. If uplift is present a red U is placed next to the affected pole. If you put the mouse over the U the numerical amount of uplift is shown in the right panel of the window. This value is for one conductor only (i.e., number of conductors is ignored) - the uplift represents the load on an individual insulator. The uplift indicator is only shown on strain poles if the option is set.

9.23 Right click menu

Right clicking with the mouse in the profile window brings up a context-sensitive menu. Differing functions are available depending upon where the mouse is clicked.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Function</th>
<th>When it is displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pole properties</td>
<td>Opens pole properties window for that pole</td>
<td>Right click on pole</td>
</tr>
<tr>
<td>Delete pole</td>
<td>Deletes selected pole</td>
<td></td>
</tr>
<tr>
<td>Snap pole left/right</td>
<td>Move the pole to the ground point to the left/right of the pole</td>
<td></td>
</tr>
<tr>
<td>Conductor properties</td>
<td>Opens segment properties for that segment</td>
<td>Right click on conductor</td>
</tr>
<tr>
<td>Retension span</td>
<td>Opens retension function</td>
<td></td>
</tr>
<tr>
<td>Real time pan</td>
<td>View functions, see section 9.19</td>
<td>All the time</td>
</tr>
<tr>
<td>Zoom extents</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy screen</td>
<td>Copies screen capture and opens in default image editing program</td>
<td></td>
</tr>
<tr>
<td>Set/clear third clearance line</td>
<td>See section 9.28.5</td>
<td></td>
</tr>
</tbody>
</table>
9.24 Component Properties

You can access the properties of poles and conductors by double-clicking on the item in the profile window. The corresponding properties page opens.

9.25 Reports

9.25.1 DXF

You can export the profile to a DXF file, which can then be opened by a CAD program. Click the Export to DXF menu under File. Enter the filename. You cannot save any files into the program directory due to Windows security restrictions.

Relative horizontal/vertical scaling is specified by entering a suitable value in the entry box. For example, if you want the scaling 1:10 so that vertical distances are scaled up by a factor of 10 then enter 100, as the horizontal scaling is considered to be 1:1000.

9.25.2 PDF

This function generates a PDF showing pole and circuit information. It opens in the default PDF viewer and you will need to save the file if you want to retain it.

You are shown a list of data that can be included in the PDF report. Select and unselect as needed; the selections will be retained. Tick “Don’t show me this again” to prevent this window from displaying each time you generate a PDF report. The selection window can be accessed at any time through the menu item Reports>Report details.

A screen capture is included in the PDF. What the profile screen is currently displaying is captured so set the profile screen to show what you need in the report before clicking the report function.

The last item in the list in Full Tipload Reports. Selecting this includes in the PDF file a tipload report for each pole, the same as is generated by the Tipload module. The next window has a list of all the poles in the profile so you can select which poles you want tipload reports for. You can select to generate a spreadsheet with an overview of the pole tiploads.
9.25.3 Pole schedule
This generates an excel file containing details of all poles in the profile, including constructions if any.

9.25.4 Conductor schedule
This generates an excel file containing details of all segments in the profile, including individual spans and sags.

9.25.5 Pole position schedule
This generates an excel file containing easting, northing and elevation values for all poles in the profile.

9.25.6 Circuit details
Generates an excel file with details of each circuit including minimum clearance and blowout.

9.26 Open an existing file
You can open profile project files created by version 6 or 7. A check is made in a version 7 file for what option set was active when the file was saved. If that set is different to the currently loaded set you will see a message. You will probably want to load the correct option set first then reopen the file. If you use a different option set to the one the project file was created with you will probably get different calculated results.

9.27 Creating a tee-off in a Profile
The Profiler is intended to operate as a 2D look at the line - ignoring deviation angles at poles and any tee-off conductors. For checking clearances that is what is required. Deviation angles at poles are easily incorporated when you import the ground line through many of the importing data formats. Tee-offs can be included in a profile for the purpose of calculating the complete tipload on the tee-off pole but are not suitable for any other purpose.

9.27.1 Definitions
Chainage  horizontal distance along the ground under the line of conductors
Easting a straight line distance running due east (or any suitable reference direction)
Northing straight line distance perpendicular to the easting, in plan view anticlockwise to the easting direction

Conductor span lengths are calculated from the Easting/Northing of the poles, not from pole chainages.

When you enter a pole it is given a chainage and also an easting and northing. Groundlines inserted manually always have a northing of zero ie they run in a straight line. Ground lines entered using one of the easting/northing formats retain that data and when poles are inserted they are given a chainage along the original ground line and a easting/northing reflecting its location relative to groundline data points.

Because span lengths are calculated from easting/northing of the two poles you can manually edit the Easting/Northing through the Pole details window as long as you realize the pole position described by its chainage no longer reflects its true location. One consequence of this is the clearance from ground may not be correct. As stated above the purpose of inserting a tee-off as described in this section is solely to calculate the tipload on the tee pole accurately.

9.27.2 A worked example

1. enter 4 poles at chainages 0, 56, 105, 167, let’s say they are labelled Pole 1 to Pole 4
2. string a conductor across the 3 spans
3. When you go to Pole Details you will see they have easting equal to chainage and northing is zero.
4. enter another pole, Pole 5, at chainage 115 and string a conductor from Pole 3 to Pole 5. Go to Pole properties (right click on the pole>properties) and change northing to 22.

This places Pole 5 10m east on Pole 3 and 22m north of the existing line of poles 1-4m which you will see in planview. The distance between poles 3 and 5 according to chainage is 10m, but in segment details you will see the circuit is \( \sqrt{10^2 + 22^2} = 24.2 \). The tipload shows that directions are correctly calculated based on the poles' eastings/
northings.

9.28 Additional Functions

9.28.1 Measure clearances

Two functions allow you to check all spans in the profile for:

- minimum clearance to ground
- minimum clearance between super-circuit and sub-circuit

You are asked for the minimum clearance and the check is performed. The report shows:

- for ground clearance: left and right poles, strain section, temperature and minimum clearance
- for inter-circuit clearance: each strain section and circuit temperature, the closest approach and the chainage for which that clearance occurs.

If the option is selected (Profiler tab in Options) only clearances between hot super and cold sub-circuits are shown in the report.

You can use this function to show clearance above ground of all the lowest conductors in each span. If you enter a large value for minimum ground clearance then all circuits will be below that and hence will all be displayed.

9.28.2 Move profile right

You are able to move the whole profile to the right in the profile screen, with a caution:

If you have imported the groundline from a survey data file then it is best not to use this function as results are unpredictable. You will get a more reliable result by editing the groundline and reimporting the data.

Click this function and enter the distance to move the profile right. Poles and ground line are moved to the right by this distance and an element representing level ground is entered at the start of the profile.

9.28.3 Retension a span

This function allows you to retension an existing span to match a desired clearance. To use this function:
1. select the span (the desired temperature curve between 2 poles) by clicking on it at the chainage where you want to modify the clearance. The line will be highlighted.

2. Click Functions>Retension span. The chainage and existing clearance will be displayed.

3. You can edit the chainage to set it to an exact value if desired. The clearance at the new chainage is shown.

4. Enter the new clearance and click Proceed.

5. The new tension for the selected segment will be calculated and the profile redrawn. The new clearance for the selected span and temperature will be matched to within about 2cm.

9.28.4 Insert text comment

Click Entities>Text comment. Click the mouse on the profile where you want the text comment to go. A window opens for you to type in your text. Click the red X to close the window and the text you will added to the profile. You may not see it until the profile is next refreshed (click Refresh now if you wish). You can move the text by grabbing and dragging it (as you would in a CAD program). Double click on the text to edit it. Delete the text in the editing box in order to delete the comment altogether.

You can use multi-line text in the profile but when exported to a DXF file it will be displayed on one line.

9.28.5 Third clearance line

Upon right clicking in the profile screen a menu is shown with two items, Set and Clear third clearance line. When you click the Set item you are asked for a clearance height and a third clearance line is drawn on the profile. You can remove this line by clicking Clear.

9.28.6 Snap pole

The function moves the selected pole to the ground point to the left or right of its current position. Span lengths and sags are recalculated and the profile redrawn.
9.29 Limitations in version 7

- When opening a version 6 profile file, independent circuits and annotations (remarks drawn on the profile) are ignored.
10 Importing into the Profiler

Data representing the groundline will generally be in one of three formats:

- chainage and level
- easting, northing and elevation
- distance, bearing and inclination

The importing tools in Poles ‘n’ Wires allow you to create a file of groundline data and then load that file directly into the Profiler. What you are able to do with your data will depend upon how you obtain it and what format it comes in. This table is a summary of common data sources and ways you can import it into the Profiler.

<table>
<thead>
<tr>
<th>Type of data</th>
<th>Methods to enter data into the Profiler</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Manual entry</td>
</tr>
<tr>
<td>chainage, level from manual survey</td>
<td>✓</td>
</tr>
<tr>
<td>distance, bearing, inclination from manual survey</td>
<td>✓</td>
</tr>
<tr>
<td>easting, northing, elevation from survey equipment</td>
<td>✓</td>
</tr>
<tr>
<td>long section from survey drawing</td>
<td>✓</td>
</tr>
<tr>
<td>pole information with the groundline</td>
<td>✓</td>
</tr>
</tbody>
</table>

This section describes the data file formats available to import groundline and/or pole data into the profile.

With most of these importing it is best not to have the file you are wanting to import open in another application (eg Excel) to avoid a locked file error.

Most importing errors are caused by incorrectly formatted data files so follow these details carefully.

With excel files particularly you need to ensure there is no other data on the sheet or you will get errors. If necessary copy just the data and paste into a new file to ensure only the correct data is present.
10.1 Easting, northing, elevation – excel file

Import easting, northing, elevation data from excel, text or DXF files. The three file formats are available in the importing function by choosing the extension in the Open file dialog.

10.1.1 Excel files

Figure 30 shows the general format of this file.

Use the option “Import easting/northing/elevation/pole/segments data” and select the excel file type to access this import format.

The sheet is named **groundline**. (This is important!)

The first line is a header line and is not used for data points.

- **required columns are:**
  - easting
  - northing
  - elevation

- **optional columns**
  - Pole ID
  - Height
  - length

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Pole1</td>
<td>9.2</td>
<td>12.4</td>
<td>3.2</td>
</tr>
<tr>
<td>3</td>
<td>40</td>
<td>0</td>
<td>0</td>
<td>Pole2</td>
<td>12.3</td>
<td>15.5</td>
<td>3.2</td>
</tr>
<tr>
<td>4</td>
<td>85</td>
<td>0</td>
<td>0</td>
<td>Pole3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>129.7</td>
<td>-14.52</td>
<td>0</td>
<td>Pole4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>169.7</td>
<td>-14.52</td>
<td>0</td>
<td>Pole5</td>
<td>15.2</td>
<td>18.5</td>
<td>3.3</td>
</tr>
<tr>
<td>7</td>
<td>214.7</td>
<td>-14.52</td>
<td>0</td>
<td>Pole6</td>
<td>13</td>
<td>15.5</td>
<td>3.2</td>
</tr>
<tr>
<td>8</td>
<td>214.7</td>
<td>28.98</td>
<td>0</td>
<td>Pole7</td>
<td>12.3</td>
<td>15.5</td>
<td>2.5</td>
</tr>
<tr>
<td>9</td>
<td>214.7</td>
<td>72.48</td>
<td>0</td>
<td>Pole8</td>
<td>13</td>
<td>15.5</td>
<td>3.2</td>
</tr>
<tr>
<td>10</td>
<td>263.3348</td>
<td>78.4516</td>
<td>0</td>
<td>Pole9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>312.3348</td>
<td>78.4516</td>
<td>0</td>
<td>Pole10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>361.3348</td>
<td>78.4516</td>
<td>0</td>
<td>Pole11</td>
<td>12.3</td>
<td>15.5</td>
<td>2.5</td>
</tr>
<tr>
<td>13</td>
<td>409.3348</td>
<td>78.4516</td>
<td>0</td>
<td>Pole12</td>
<td>13</td>
<td>15.5</td>
<td>2.5</td>
</tr>
<tr>
<td>14</td>
<td>443.1888</td>
<td>119.6403</td>
<td>0</td>
<td>Pole13</td>
<td>13</td>
<td>15.5</td>
<td>3.2</td>
</tr>
<tr>
<td>15</td>
<td>434.0617</td>
<td>171.3003</td>
<td>0</td>
<td>Pole14</td>
<td>12.3</td>
<td>15.5</td>
<td>3.2</td>
</tr>
<tr>
<td>16</td>
<td>429.7671</td>
<td>223.7575</td>
<td>0</td>
<td>Pole15</td>
<td>12.3</td>
<td>15.5</td>
<td>3.2</td>
</tr>
</tbody>
</table>

Figure 30: Format for easting, northing, elevation file, data sheet
- sinking depth

If you include a Pole ID column for any row you need to also include at least the pole height (out of ground) on that row. You can optionally include pole length; if omitted the program will assume the pole length is the same as pole height with sinking depth of zero.

You can use xls or xlsx format files.

10.1.2 Excel file - optional Sheet 2 - Circuit segment data

If you have included poles in the first sheet you can optionally have circuit segments in the spreadsheet as well.

1. First line is header line and is not used for data points
2. sheet to be named Segments
3. required columns
   a) conductor code (from conductor library)
   b) number of conductors
   c) stringing tension %CBL
   d) Stringing tension kN
   e) stringing tension Table
   f) temperature conditions
   g) poles
   h) attachment heights

   Data in one only of columns c, d or e

Example format for sheet 2 is shown in figure 31.

![Figure 31: Format for circuit segment data, sheet named "segments"](image-url)
Notes for this sheet:

1. Stringing tension – specify tension by one of %CBL, a kN value or Table value. The first of columns c, d or e that has a value will be used for the stringing tension for that segment and the other two columns will be ignored.

2. Temperature conditions – values for the conductor temperatures for this segment. You can enter a maximum of 4 temperatures. Colours are assigned to the temperatures in order from 1 to 4 from the option settings. The label is given “Tempx”, x being 1 to 4.

3. Attachment heights – each segment can have only one attachment height on each pole, just as when you attach a segment manually in the profile module.

4. Any sheets in the spreadsheet other than the sheets named groundline and Segments will be ignored.

10.2 Easting, northing, elevation - Text file

Figure 32: Format for tab delimited text file

<table>
<thead>
<tr>
<th>Easting</th>
<th>northing</th>
<th>elev</th>
<th>id</th>
<th>ht</th>
<th>len</th>
<th>sunk</th>
</tr>
</thead>
<tbody>
<tr>
<td>28356858.46</td>
<td>6214090.29</td>
<td>329.92</td>
<td>1434111</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833045.12</td>
<td>6214015.02</td>
<td>319.94</td>
<td>143110</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833088.58</td>
<td>6214007.51</td>
<td>314.20</td>
<td>130774</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833076.05</td>
<td>6213983.52</td>
<td>311.77</td>
<td>143408</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833085.99</td>
<td>6213986.60</td>
<td>309.17</td>
<td>143408</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833013.56</td>
<td>6213866.16</td>
<td>299.57</td>
<td>143408</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833084.12</td>
<td>6213810.20</td>
<td>290.20</td>
<td>143407</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833085.65</td>
<td>6213715.24</td>
<td>298.94</td>
<td>143406</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833069.21</td>
<td>6213650.28</td>
<td>302.70</td>
<td>150043</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833967.49</td>
<td>6213584.45</td>
<td>306.92</td>
<td>143404</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833970.53</td>
<td>6213530.76</td>
<td>306.36</td>
<td>143403</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833971.46</td>
<td>6213517.39</td>
<td>306.56</td>
<td>143403</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833894.07</td>
<td>6213498.48</td>
<td>306.36</td>
<td>143402</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833026.64</td>
<td>6213472.04</td>
<td>306.92</td>
<td>143402</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833094.99</td>
<td>6213598.63</td>
<td>302.96</td>
<td>143401</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833236.35</td>
<td>6213200.70</td>
<td>314.00</td>
<td>143400</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833252.75</td>
<td>6213169.58</td>
<td>314.52</td>
<td>143400</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833507.74</td>
<td>6213135.65</td>
<td>314.92</td>
<td>143399</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2833583.30</td>
<td>6213016.05</td>
<td>312.87</td>
<td>143398</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2834925.95</td>
<td>6212721.72</td>
<td>328.02</td>
<td>143397</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
<tr>
<td>2834926.33</td>
<td>6212701.02</td>
<td>329.19</td>
<td>143396</td>
<td>10.4</td>
<td>12.50</td>
<td>2.1</td>
</tr>
</tbody>
</table>

Use the option “Import easting/northing/elevation/pole/segments data” and select the text file type to access this import format.

You can separate the columns using a comma or a single tab. If you use a number
format with comma as the decimal marker you must use tabs to separate the columns.
The information in the columns is the same as described for excel files in section 10.1.1.

10.3  Easting, northing, elevation - DXF file

You can create a polyline in a CAD file that connects a series of 3D points. The vertices will have \( x, y \) and \( z \) coordinates that correspond to easting, northing and elevation of the data points on the groundline. The polyline shows Poles 'n' Wires the order of points along the groundline.

- the polyline must be on layer by itself
- the layer must be named pnwground
- other data can be present in the file; it will be ignored.
- save the file as a text DXF file, preferably as a DXF 2007 or earlier file
- a 2D CAD program (eg Autocad LT) cannot create a 3D polyline so you cannot use that to create the DXF file

If you want to create datapoints that have only easting/northing values use zero for the \( z \) coordinate. After importing the data you can enter suitable levels (elevations) manually within the profile module.

Use the option “Import easting/northing/elevation/pole/segments data” and select the DXF file type to access this import format.

10.4  Long section (chainage/level) DXF file

A long section is really a chainage and level type file. If you have obtained a long section from a surveyor you can import it into the Profiler.

Use the option “Import chainage/level from DXF file” to access this import format.

10.4.1  General Points

1. save in the oldest version DXF available to assist compatibility
2. you need to know what the scaling is, horizontally and vertically
3. the first point of the groundline you create in the file will be inserted at chainage 0, level 0 in the profile

10.4.2  Ground line

1. Ground line data must be on a layer by itself
2. only lines and polylines are processed; you will get best results if you have the groundline drawn as one polyline

10.4.3 Poles

1. poles can be drawn on a separate layer
2. the distance between bottom and top of a vertical line is taken as the pole height above ground, scaled suitably
3. X coordinate of the line is taken as chainage
4. text drawn at the same insertion point as the pole “base” is taken as pole ID, otherwise an “auto” ID is given

![Long section as one polyline](image)

*Figure 33: Long section as one polyline*

10.5 Chainage/level text file

A series of data pairs comprising a chainage (relative to zero) and the elevation at that chainage.

1. each pair of data points (chainage, level) is on a line by itself, separated by comma, space or tab. If you use a number format with comma as the decimal place you must use space or tab to separate the numbers.
2. all data is taken relative to chainage 0 and level 0, so for example if your first point is chainage 300, level 52, that is where it will be drawn in in the profile.
3. Example format in figure 34.

<table>
<thead>
<tr>
<th>Chainage</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>0,0</td>
<td></td>
</tr>
<tr>
<td>140,0</td>
<td></td>
</tr>
<tr>
<td>155,1</td>
<td></td>
</tr>
<tr>
<td>270,4</td>
<td></td>
</tr>
<tr>
<td>425,3</td>
<td></td>
</tr>
<tr>
<td>506,4.2</td>
<td></td>
</tr>
<tr>
<td>580,4</td>
<td></td>
</tr>
<tr>
<td>615,4</td>
<td></td>
</tr>
<tr>
<td>700,3</td>
<td></td>
</tr>
<tr>
<td>780,2.5</td>
<td></td>
</tr>
</tbody>
</table>

Use the option “Import chainage/level from text file” to access this import format.
10.6 Distance, Bearing, Inclination Excel file

Use this selection to import distance, bearing and inclination data in Excel xls or xlsx files. Sample formats shown in figures 36 and 37.

10.6.1 Data points

Data points can be:

1. relative to the one reference point, or
2. each data point is relative to the previous data point

10.6.2 File format

1. The data must be on the first sheet of the file.
2. first line is the header line and is not used for data points
3. required columns
   a) distance
   b) bearing. Compass directions with 0° being North
   c) inclination. This can be from 0° to 180° with 0° being straight down and 180° up, or -90° to +90°.
4. optional columns
   a) Pole ID
   b) Height
   c) length
   d) sinking depth

If you include a Pole ID column for any row you need to also include at least the pole height (out of ground) on that row. You can optionally include pole length; if omitted the program will assume the pole length is the same as pole height with sinking depth of zero.

After selecting the Import function in the Profile module and selecting a file, you will be asked to describe the data format. See figure 35. Choose the ap-
appropriate option then click Continue.

10.6.3 Example file formats

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distance</td>
<td>Bearing</td>
<td>Inclination</td>
<td>Pole ID</td>
<td>Height</td>
<td>Length</td>
<td>Sinking</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>0</td>
<td>P24322</td>
<td>8.7</td>
<td>10.5</td>
<td>1.7</td>
</tr>
<tr>
<td>3</td>
<td>83</td>
<td>0</td>
<td>P24587</td>
<td>8.7</td>
<td>10.5</td>
<td>1.7</td>
</tr>
<tr>
<td>4</td>
<td>163</td>
<td>-5</td>
<td>P24586</td>
<td>9.8</td>
<td>12</td>
<td>2.2</td>
</tr>
<tr>
<td>5</td>
<td>262</td>
<td>-5</td>
<td>P24685</td>
<td>8.3</td>
<td>10</td>
<td>1.7</td>
</tr>
<tr>
<td>6</td>
<td>246</td>
<td>-7</td>
<td>P24683</td>
<td>8.3</td>
<td>10</td>
<td>1.7</td>
</tr>
<tr>
<td>7</td>
<td>426</td>
<td>-10</td>
<td>P24582</td>
<td>8.3</td>
<td>10</td>
<td>1.7</td>
</tr>
<tr>
<td>8</td>
<td>486</td>
<td>-2</td>
<td>P24581</td>
<td>9.2</td>
<td>11.5</td>
<td>1.8</td>
</tr>
<tr>
<td>9</td>
<td>567</td>
<td>0</td>
<td>P24579</td>
<td>8.3</td>
<td>10</td>
<td>1.7</td>
</tr>
<tr>
<td>10</td>
<td>642</td>
<td>2</td>
<td>P24577</td>
<td>8.3</td>
<td>10</td>
<td>1.7</td>
</tr>
<tr>
<td>11</td>
<td>714</td>
<td>45</td>
<td>Site 1</td>
<td>9.2</td>
<td>11</td>
<td>1.8</td>
</tr>
<tr>
<td>12</td>
<td>792</td>
<td>70</td>
<td>P24574</td>
<td>9.2</td>
<td>11</td>
<td>1.8</td>
</tr>
</tbody>
</table>

**Figure 36:** All points are relative to the starting point

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distance</td>
<td>Bearing</td>
<td>Inclination</td>
<td>Pole ID</td>
<td>Height</td>
<td>Length</td>
<td>Sinking</td>
</tr>
<tr>
<td>2</td>
<td>10</td>
<td>7.58</td>
<td>90</td>
<td>2098</td>
<td>8.84</td>
<td>10.6</td>
</tr>
<tr>
<td>3</td>
<td>10</td>
<td>7.58</td>
<td>90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>10</td>
<td>7.58</td>
<td>100</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>7.58</td>
<td>120</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>10</td>
<td>7.58</td>
<td>110</td>
<td>1</td>
<td>8.84</td>
<td>10.6</td>
</tr>
<tr>
<td>7</td>
<td>10</td>
<td>7.58</td>
<td>90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>10</td>
<td>7.58</td>
<td>90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>10</td>
<td>7.58</td>
<td>80</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>7.58</td>
<td>90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>10</td>
<td>7.58</td>
<td>90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>10</td>
<td>7.58</td>
<td>100</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>10</td>
<td>7.58</td>
<td>100</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>10</td>
<td>7.58</td>
<td>100</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>10</td>
<td>7.58</td>
<td>100</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>5</td>
<td>7.58</td>
<td>90</td>
<td>5</td>
<td>8.84</td>
<td>10.6</td>
</tr>
<tr>
<td>17</td>
<td>5</td>
<td>7.58</td>
<td>90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>10</td>
<td>7.58</td>
<td>80</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>10</td>
<td>7.58</td>
<td>90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>10</td>
<td>7.58</td>
<td>80</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>10</td>
<td>7.58</td>
<td>90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>10</td>
<td>7.58</td>
<td>60</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>10</td>
<td>7.58</td>
<td>60</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>10</td>
<td>7.58</td>
<td>140</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>10</td>
<td>7.58</td>
<td>90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>10</td>
<td>7.58</td>
<td>100</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>2</td>
<td>7.58</td>
<td>90</td>
<td>2</td>
<td>8.84</td>
<td>10.6</td>
</tr>
<tr>
<td>28</td>
<td>8</td>
<td>298.56</td>
<td>100</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>10</td>
<td>298.56</td>
<td>100</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>10</td>
<td>298.56</td>
<td>100</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>10</td>
<td>298.56</td>
<td>100</td>
<td>35</td>
<td>8.84</td>
<td>10.6</td>
</tr>
</tbody>
</table>

**Figure 37:** Points are relative to each preceding point
Use the option “Import distance/bearing/inclination/pole data” to access this import format.

10.7 Excel file, easting, northing, elevation, poles, constructions

This format is similar to the format in section 10.1 with the addition of specifying a pole type and putting constructions on the poles. You can use xls or xlsx format files.

10.7.1 Groundline and pole data

Use the option “Import easting/northing/elevation, poles with constructions” to access this import format.

The sheet is named groundline. (This is important!)

The first line is a header line and is not used for data points.

The first 4 columns are:

- easting
- northing
- elevation
- pole ID

Column 5, pole type. Select a code from the Poles database.

Columns 6 and 7 are left blank for compatibility with version 6.

Column 8, sinking depth. If you are using the default sinking depth from the database you can leave this column blank.

Column 9, construction. Select a code from the Constructions database.

Column 10, attachment height of the construction.
For any particular pole the first line will have all the above data. Subsequent lines can have only the construction code and attachment height as shown in figure 38.

### 10.7.2 Segments data

A second sheet in the file, named Segments, contains details of conductors and the constructions they are attached to on each pole.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>conductor</td>
<td>num cond</td>
<td>%CBL</td>
<td>std tens</td>
<td>table</td>
<td>temp</td>
<td>poles</td>
<td>constr</td>
<td>attht</td>
</tr>
<tr>
<td>RA</td>
<td>3</td>
<td>18</td>
<td>5.65</td>
<td>143411</td>
<td>11T</td>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>143410</td>
<td>11P</td>
<td>7.8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>130774</td>
<td>11T</td>
<td>7.9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MO</td>
<td>4</td>
<td>12</td>
<td>15.75</td>
<td>143411</td>
<td>LVT</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>143410</td>
<td>LVP</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>130774</td>
<td>LVP</td>
<td>6.5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>143408</td>
<td>LVT</td>
<td>6.4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BA</td>
<td>3</td>
<td>3</td>
<td>5.65</td>
<td>143408</td>
<td>11T</td>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>143407</td>
<td>11S</td>
<td>8.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. First line is header line and is not used for data points
2. Sheet to be named Segments
3. Required columns
   a) conductor code (from conductor library)
   b) number of conductors
   c) stringing tension %CBL
   d) Stringing tension kN
   e) stringing tension Table
   f) temperature conditions
   g) poles
   h) constructions
   i) attachment heights of constructions

Notes for this sheet:

1. Stringing tension – specify tension by one of %CBL, a kN value or Table value. The first of columns c, d or e that has a value will be used for the stringing tension for that segment and the other two columns will be ignored.
2. Temperature conditions – values for the conductor temperatures for this segment. You can enter a maximum of 4 temperatures. Colours are assigned to the
temperatures in order from 1 to 4 from the option settings. The label is given “Tempx”, x being 1 to 4.

3. Constructions. Select a construction from the database. The construction for a segment on a pole will be on the same line as the pole.

4. Attachment height of the construction. This is specified as it is possible to have more than one construction of the same type on a pole, so you need to differentiate them by the attachment height. The construction/attachment height combination needs to match the details on the groundline sheet.

5. Any sheets in the spreadsheet other than the sheets named groundline and Segments will be ignored.
11 Pole Strength Module

This module calculates the strength of a pole from the timber species properties and the pole specifications. You can use the safety factor method or the limit state method (described in AS7000:2016 appendix F).

Species data for this module is taken from the Species database (section 5.3).

11.1 Safety factor method

This is the default method (change method by clicking on the tab).

1. Enter pole height, optionally length and sinking depth.
2. Select species from the dropdown.
3. Select the ground level section that corresponds to the field data. After clicking the image the window will change to show the required measurements for the selected ground level section.

Ground diameter is the external diameter at ground level.

a) Solid. No decay.

b) Central pipe. Decay runs through the middle of the pole. Defined by the two distances of good wood on the outside of the pole.
c) One-sided decay. Defined by a distance of good wood, then the distance of the decay cavity.

d) Two-sided decay. Enter the good wood and cavity distances from each side.

e) Rectangular pole. Enter length of face and side. The side dimension is in the direction of the maximum load on the pole.

4. Calculate. Results for safety factor method are:

- Loading 1 – wind loading
- Loading 2 – no wind loading

Results given are for tipload and bending moment for each load case.

5. Print. Generate a PDF report of the pole and strength calculation.

There is an option to deduct the wind load on the pole from the pole strength. Some utilities use this approach. To make this allowance tick to select and enter values for average above ground diameter, poletop allowance and wind pressure in Pascals.

11.2 Limit state method

Click the tab to show the limit state method data required.

Most values are completed from defaults based on the calculation method shown in AS7000:2016. You can edit any values as required.

Enter pole details as described in section 11.1.
11.2.1 Variables

Most values are completed from defaults based on the calculation method shown in AS7000:2016. You can edit any values as required.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Remarks</th>
<th>Typical values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Degradation factor</td>
<td>Allow for loss of strength and stiffness associated with degradation of the critical section of the pole at and below the ground line over its expected design life</td>
<td>See AS7000:2016 table F5</td>
<td>0.3 – 1.0</td>
</tr>
<tr>
<td>Capacity reduction factor</td>
<td>To cover variations in material properties and other inaccuracies</td>
<td>See AS7000:2016 table F3</td>
<td>0.9 – 0.95</td>
</tr>
<tr>
<td>Diameter taper</td>
<td>Taper from butt to nominal groundline level</td>
<td>Not used in calculation</td>
<td>10-12mm/m</td>
</tr>
<tr>
<td>Mid length taper</td>
<td>Taper from nominal groundline level to mid-point (above ground) of pole</td>
<td>Property is in database</td>
<td>8-10mm/m</td>
</tr>
<tr>
<td>Timber density</td>
<td></td>
<td>Property is in database</td>
<td></td>
</tr>
<tr>
<td>Duration factors 1 &amp; 2</td>
<td>Modification factor reflecting load duration</td>
<td>See AS7000:2016 table F4</td>
<td>0.57, 1.0</td>
</tr>
<tr>
<td>Compression factor</td>
<td>Dead load factor applied to known loads</td>
<td></td>
<td>1.2</td>
</tr>
<tr>
<td>Effective length factor</td>
<td>Allowance for conditions of end supports of pole</td>
<td>Defined in AS-7000:2016 as 1.15</td>
<td>1.15</td>
</tr>
<tr>
<td>Immaturity factor</td>
<td>Allowance for the properties of immature timber</td>
<td>See AS7000:2016 table F6</td>
<td>0.75 – 1.0</td>
</tr>
<tr>
<td>Shaved – bending and compression factors</td>
<td>Design characteristic strength properties should be reduced if the poles have been shaved, when modified from the natural pole form</td>
<td>See AS7000:2016 table F7</td>
<td>0.75 – 1.0</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Remarks</td>
<td>Typical values</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>----------------------------------------------------</td>
</tr>
<tr>
<td>Steamed – processing factor</td>
<td>Where poles are steamed under pressure as a part of the manufacturing and fabrication process, the characteristic strength properties should be reduced</td>
<td>See AS7000:2016 section F4.7</td>
<td>poles that are steamed, 0.85, otherwise 1.0</td>
</tr>
<tr>
<td>Additional compressive load</td>
<td>This value in kilograms represents pole-mounted plant (e.g., a transformer) or conductor vertical loads and affects horizontal and vertical strength capacity</td>
<td>Can be set to actual masses if known, otherwise an assumed load (excludes self-weight of pole)</td>
<td></td>
</tr>
</tbody>
</table>

11.2.2 Print

A PDF report is generated.

11.2.3 Save to Database

This function allows you to save the pole specifications into the Poles database for use in a profile or tipload project. It is saved with the Code taken from the ID you have entered. You can enter a Set name so you can filter poles in future use.

You can save the pole data to the database only for this instance of Poles 'n' Wires, or permanently. If you choose PERMANENT the pole will be always be available for future projects. If you choose TEMPORARY the pole will be available until you close the software, saved with any project files you use the pole in, and also saved in to a temporary database allowing its use in future projects.

11.3 Results

Click Calculate to get the results. Results for two load cases are shown.

Loading 1 covers wind and other short term loadings.

Loading 2 is for long term, dead loads (no wind).

If you see a N/A (not applicable) result it means something in the configuration of the project leads to an invalid result. For example if the additional compressive load is too high for the species and size of the pole, meaning the pole would fail, you will see the
11.4 Limit state method – batch processing

This function processes a spreadsheet containing data from pole inspections allowing multiple calculations in one step.

11.4.1 File format

This is the required file format of the excel file:

<table>
<thead>
<tr>
<th>Column</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>pole ID</td>
</tr>
<tr>
<td>B</td>
<td>pole length</td>
</tr>
<tr>
<td>C</td>
<td>pole height above ground</td>
</tr>
<tr>
<td>D</td>
<td>sunk depth</td>
</tr>
<tr>
<td>E</td>
<td>species</td>
</tr>
<tr>
<td>F</td>
<td>hard/soft wood</td>
</tr>
<tr>
<td>G</td>
<td>ground diameter</td>
</tr>
<tr>
<td>H</td>
<td>Solid 1 dimension</td>
</tr>
<tr>
<td>I</td>
<td>Solid 2 dimension</td>
</tr>
<tr>
<td>J</td>
<td>Decay dimension</td>
</tr>
<tr>
<td>Column</td>
<td>Remarks</td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
</tr>
<tr>
<td>K</td>
<td>Additional compressive load</td>
</tr>
<tr>
<td>L</td>
<td>remarks</td>
</tr>
</tbody>
</table>

Columns H to J define the interior decay. You can use these combinations of data:

- **Solid 1 with data, Solid 2 and Decay blank**
  - Solid 1 dimension is taken as the solid dimension on both sides, with central decay. If Solid 1 is ½ of groundline diameter then the pole is analysed as a solid pole.

- **Solid 1 and Solid 2 with data, Decay blank**
  - Central decay with different dimensions of solid on each side.

- **Solid 1 and Decay with data, Solid 2 blank**
  - One sided decay - solid 1 dimension on one side then decay dimension.

### 11.4.2 Settings

Variables set on the Limit state method tab are used for the batch processing except for the following (these are taken or derived from the data file):

- pole degradation setting – hardwood or softwood
- tapers – diameter and mid length
- timber density
- additional compressive load

### 11.4.3 How to use

1. Set up an excel file with the data. Save the file.
2. Click Browse to locate the excel file (xls or xlsx) to process.
3. Tick the save to database option if you want to save the data of any successfully processed file into the Poles database (permanent or temporary) for use in subsequent projects. If you do not select this setting the pole data is not retained and only a PDF report is generated.
4. (Optional) Enter a set name for the collection of poles to be saved with in the Poles database. This allows you to later filter or sort the entries. This can be a new or existing set name.
5. Click Process. When completed a summary is shown and a PDF file containing all reports is opened. You are advised of any poles that could not be processed.

11.5 Note on calculation method

This module uses the calculation method described in AS7000:2010 appendix F. That standard states that its contents are intended for use with new installations ie poles with no decay.

When assessing a decayed pole a simplified approach is taken of reducing the total pole cross-sectional area by the area of decay ignoring the location of the decay within the pole. This is the traditional assumption used for timber distribution poles.
12 Conductor Search window

This window allows you to locate the code of the conductor you want to use. It opens with all conductors in the database.

To filter the results, select the field then type in the Search Criteria box. You can use wild cards (* and ?). Select = or LIKE in the centre selection to look for an exact match or a similar match. Click Apply.

To use the code you have located click in the left grey column of that row to highlight the row. Click Use. The window will close and the code will be entered in the correct position on your previous window.

Click Close to close the window without selecting a code.
13 Stringing Table generator

The stringing table module creates tables in various formats.

Format 1 is a table with temperatures across the rows and columns being span lengths. You can show sags (distance or times/waves), blowout or actual tension.

Format 2 is a smaller table showing sag, time and actual tension for temperatures for one span length, usually a Ruling span.

After opening the stringing table module select the tab for the desired format. Enter the following information as needed.

13.1 Data required

- Lengths. Minimum and maximum length for spans with increment. For ex-
ample if you want to show every 10m between 50 to 150m you would enter:

- **minimum** 50
- **maximum** 150
- **increment** 10

- **Ruling Span/MES (format 1).** You have the option to set RS to each span length, or use one RS length for all spans. If you double-click in this text box the MES calculator module opens allowing you to calculate the MES from span lengths. Click Return or close the window and the MES is entered in the text box.

- **Ruling Span/MES (format 2).** Enter the Ruling span for the strain section you are examining. If you double-click in this text box the MES calculator module opens allowing you to calculate the MES from span lengths. Click Return or close the window and the MES is entered in the text box.

- **Temperatures.** As for lengths, set minimum, maximum and increment temperatures. Standard temperature is taken from Options and is usually not altered.

- **Tension.** Select the tension type from the drop-down and enter a suitable value.

- **Wind loads.** Wind load is used only in Format 1 for Actual tension calculation. Blowout wind pressure is used only for Blowout calculations.

- **Loading.** You can select from available ice or snow loadings, as set in Options.

### 13.2 Generate report

- **Save.** Enter a filename or click Browse to show a file dialog window. Files are saved as excel files.

- **Result.** Select the required type of result (format 1). Format 2 gives a fixed report layout.

Click *Generate* to create an excel file in your previously selected location.
14 Conductor Ratings Calculator

This module takes conductor parameters and environment conditions and calculates the maximum current the conductor can carry. It can also calculate the theoretical conductor temperature for a known current flowing in the conductor.

This is a metric only module.

14.1 Conductor Selection

Enter a conductor code in the Conductor textbox. It will auto-complete as you commence typing. If you don't know the code double click in the box to open the conductor selection function.

Only conductors that are not insulated and have values in the database for DC resistance at 20°C and temperature coefficient of resistance are available for selection.

Data for Composite conductor must be correctly formatted in the database if you wish to use it in this module. See section 5.2.1 for details.

14.2 Parameters

Descriptions of parameters for this module follow. These values are initially set by defaults in Options but can be manually altered as needed.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solar absorption coefficient</td>
<td>A measure of the incident solar radiation the conductor surface can absorb, ranging in value from 0 (reflective surface) to 1 (perfectly absorbent surface). As a guide, the solar absorption coefficient is 0.6 for new bright conduct-</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Emissivity</td>
<td>A measure of the efficiency with which the surface radiates heat, ranging from 0 to 1. As a guide, emissivity is 0.3 for new bright conductors and 0.9 for old or blackened conductors. Values in the range 0.6 - 0.85 are typical for in-service conductors.</td>
</tr>
<tr>
<td>Line to Line Voltage</td>
<td>This value is used to convert the current rating into a MV.A rating.</td>
</tr>
</tbody>
</table>
| Design Temperature         | The conductor design temperature will be set according to the chosen rating type. To change the default conductor design temperature, refer to Options. The current rating improves dramatically with increasing temperature. However, the temperature should not be so high that: | - there is partial annealing or loss of tensile strength  
  - the line sags excessively and clearances are not maintained.  
Values of 75°C are typical for normal ratings. However, higher values may be used for short-term emergency ratings and for new high temperature conductors.|
| Ambient temperature        | Nominal actual air temperature                                                                                                                                                                                                                                           |
| Ambient temperature rise   | difference between the conductor design temperature and ambient temperature.                                                                                                                                                                                                |
| Wind velocity              | The user may modify the wind velocity to suit the local weather conditions. Increasing wind velocity affects conductor ratings significantly.                                                                                                                                   |
| Wind angle to conductor    | Incident angle of the wind to the conductor, ranging from 0 to 90 degrees. An incident angle of 0° means the wind is parallel to the line. An incident angle of 90° means the wind is perpendicular to the line.                                                                                      |
| Intensity of solar radiation| Set according to the chosen category. To change the default values, refer to Options. Values of 1000 W/m² are typical, but this will vary with latitude and season.                                                                                                                    |
| Ground reflectance factor  | Set according to the default value in Options.                                                                                                                                                                                                                             |
14.3 Selection of Rating Type and Category

The rating type and category will be set according to the default values in Options. To change the rating type, click the radio button for either ‘Normal’ or ‘Emergency’ condition. This will set the wind velocity and maximum conductor temperature accordingly.

To change the category type, click the radio button on the desired category ‘Summer Day’, ‘Winter Day’, ‘Summer Night’ or ‘Winter Night’. This will set the solar radiation and ambient temperature accordingly.

- For night-time ratings set Intensity of solar radiation to nil.

14.4 Results

To calculate the conductor rating click the ‘Calculate’ button. If all input fields are valid then the results will be presented.

The program calculates the current rating of the conductor for the specified conditions in amperes (A) and delivered 3Ø apparent power in megavolt-amperes (MV.A). It also displays these intermediate results:

<table>
<thead>
<tr>
<th>Description</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heat absorbed due to solar radiation</td>
<td>thermal input per unit length by solar irradiation in Watts per metre (W/m)</td>
</tr>
<tr>
<td>Heat generated from conductor losses</td>
<td>thermal input per unit length due to ‘I²R’ losses in the conductor in Watts per metre (W/m)</td>
</tr>
<tr>
<td>Heat loss due to convection</td>
<td>thermal output per unit length by convection in</td>
</tr>
</tbody>
</table>
### Heat loss due to radiation

<table>
<thead>
<tr>
<th>Description</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Watts per metre (W/m)</td>
<td>thermal output per unit length by solar radiation in Watts per metre (W/m)</td>
</tr>
</tbody>
</table>

**14.5 Temperature from current**

You may also do the reverse calculation – enter a current and derive the design temperature that will give rise to that current under the selected conditions.

Enter the current under the Calculate button as shown in figure 41, then click the button above. The temperature is shown in the results area on the window.

![Figure 41: Enter the current](image)

**14.6 Printing a Report**

Click File>Print to generate a PDF report of the results.

**14.7 Saving a Study**

Click File>Save to save a conductor ratings study. Enter a project/study name when prompted to do so (if the project name hasn’t already been entered) and click OK. The save file dialog box will appear, in which the filename of the study is to be entered (defaults to project/study name, plus extension .pnwx). You may nominate the folder in which the file is stored.

**14.8 Opening a Study File**

Click File>Open to open an existing conductor ratings study file. Browse to the file then click the Open button.

**14.9 Calculation method**

This module uses calculation methods described in various documents including AS7000, IEC 61597 and Cigre Electra no 144.
15 Line Reactance Module

15.1 Conductor Selection

Enter a conductor code in the Conductor textbox. It will auto-complete as you commence typing. If you don't know the code double click in the box to open the conductor selection function.

Only conductors that are not insulated are available for selection.

Data for Composite conductor must be correctly formatted in the database if you wish to use it in this module. See section 5.2.1 for details.

15.2 Parameters

15.2.1 Supply Frequency

The standard supply frequency is set according to the default value in Options.

15.2.2 Correction Factor

A correction factor may be entered to account for the effect of the steel core in conductors such as ACSR. Otherwise set this value to zero.

The program calculates inductance according to the following formula:

\[ L = 0.2 \log_e \left( \frac{GMD}{GMR} + k \right) \]

where:
• L is the inductance of the line (mH/km)
• GMD is the geometric mean distance between conductors (m)
• GMR is the geometric mean radius of conductor (m)
• k is a correction factor.

15.2.3 Conductor Heights

The average height above ground for each phase of the line is approximately equal to the conductor attachment height at the supports less two-thirds of the maximum mid-span sag.

15.2.4 Interphase Distances

Enter in the distances between phases in metres.

15.3 Results

To calculate the line reactance click the ‘Calculate’ button. If all input fields are valid then the results will be calculated and displayed on screen.

The program calculates the following electrical line parameters:

• Line capacitance in nanofarads per kilometre (nF/km).
• Shunt line capacitive reactance in ohm kilometres (MΩ.km).
• Line inductance in millihenrys per kilometre (mH/km).
• Line inductive reactance per kilometre in ohms per kilometre (Ω/km).
• Characteristic Impedance of the line in ohms.

15.4 Printing a Report

Click the menu item File>Print to generate a PDF report of the results.

15.5 Saving a Study

Click File>Save to save a reactance study. The save file dialog box will appear, in which the filename of the study is to be entered (defaults to project/study name, plus extension .pnwx). You may nominate the folder in which the file is stored.

15.6 Opening a Study File

Click File>Open to open an existing reactance study file. Browse to the file then click the Open button.
16 Conductor Spacing module

Conductors need to be spaced to prevent clashing and/or flashover under operating conditions. Your local electricity authority will provide values for separation to cater for movement of conductors under wind conditions.

This module allows you to determine suitable spacing of conductor attachment points using variables such as vertical spacing, cross arm lengths and sag. You can calculate the spacing of two conductors in the same circuit (eg two 22kv conductors) or two conductors of different circuits (such as one LV conductor and one HV conductor) when both conductors are attached to the same two poles. There are two approaches to spacing:

1. given the dimensions of the construction you can work out the maximum safe sag and therefore span length, or
2. knowing the vertical spacing of the construction and sag you can determine what length cross arm is needed

The formula used by this module is found in AS7000:2010 sect 3.7.3.2.

Opening the module you will see the window shown below.

16.1 Calculating maximum sag/span length

Select the first tab to work out the maximum sag that avoids clashing given the constructions on the two poles. From the sag you can then calculate the maximum span length.

Step 1 Enter the relative spacings on each pole. If the construction on pole 2 is the
same as pole 1 just tick the box. The data will be copied from pole 1 to pole 2

Step 2  Edit the default values in the Common Values section as required

Step 3  Click the green calculate button. The result (maximum sag) will be displayed.

If you click the Send sag to sag tension calc button the calculated maximum sag will be inserted into the sag tension window if already open, or inserted when the sag tension window is next opened.

16.2 Calculating cross arm length

The second tab allows you to calculate the needed horizontal spacing between conductors if you know the vertical spacing and maximum sag. This allows you to select a suitable cross arm length.

The window is shown in figure 42.

![Figure 42: Cross arm length tab](image)

Step 1  Enter the vertical separation and sag

Step 2  Click calculate. The minimum horizontal spacing between attachment points will be shown. You can select a suitable cross-arm that will allow this minimum spacing between insulators.
16.3 Common Values

These values are filled with default values initially and can be edited as needed.

16.3.1 Max Suspension Insulator length

The length of any free swing suspension insulator associated with either conductor. Use the longer value if they are different at the two ends. Use zero if pin or post insulators.

16.3.2 Line to line voltage

This value is the RMS (root mean square) vector difference in potential in kV between the two conductors when each is operating at its nominal voltage. In determining the potential between conductors of different circuits or between an earthwire and an aerial phase conductor attention should be paid to any phase differences in the nominal voltages.

16.3.3 Mid span separation constant

A constant normally equal to 0.4. Where local conditions have shown that other values are appropriate you can use those. AS7000:2010 section 3.7.3 gives recommended values for extreme conditions such as high bushfire prone areas.

16.4 Other functions

16.4.1 Clear

Clear results and reset options to defaults.

16.4.2 Print

Generates a PDF report.
17 Set up for working stress

Working stress methods have been commonly used for distribution line design (particularly using wood poles). Set up Poles 'n' Wires for this design approach as below.

17.1 Database

If using the pole database, the following fields are needed:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>Unique code</td>
</tr>
<tr>
<td>Length</td>
<td>Full length of pole from butt to tip</td>
</tr>
<tr>
<td>Default Sinking</td>
<td>Sinking depth</td>
</tr>
<tr>
<td>Default Height</td>
<td>Height of pole tip above ground. Will equal length - sinking depth</td>
</tr>
<tr>
<td>Diameter average</td>
<td>Average above ground diameter. Used to calculate wind load on pole</td>
</tr>
<tr>
<td>Strength: no wind</td>
<td>Maximum tip capacity of pole for sustained/everyday load conditions</td>
</tr>
<tr>
<td>Strength: wind 1</td>
<td>Maximum tip capacity of pole for short duration wind load conditions</td>
</tr>
<tr>
<td>Strength: vertical</td>
<td>Vertical strength capacity</td>
</tr>
<tr>
<td>Round Pole</td>
<td>Tick if a round pole</td>
</tr>
</tbody>
</table>

Optional fields:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Description</td>
</tr>
<tr>
<td>Material</td>
<td>Eg wood, steel</td>
</tr>
<tr>
<td>Weight</td>
<td>In kg or lbs. Used for assessing vertical load</td>
</tr>
<tr>
<td>Strength: wind 2</td>
<td>Allows for a second wind loading in calculations</td>
</tr>
<tr>
<td>Remarks</td>
<td>Remarks</td>
</tr>
</tbody>
</table>

The following fields are not used for working stress calculations:
• diameter, tip long
• diam GL longitudinal
• strength: ultimate

17.2 Load combinations (Options)

All factors need to be set to 1. Examples are shown in figures 43 and 44 of suitable option values for no wind and wind calculations.

17.3 Pole top allowance

This option is set on the tipload tab in Options. This is a value that makes allowance for crossarms, insulators etc. A typical value is 1.1 which represents a 10% loading.
18 Set up for Limit state design

Set up Poles 'n' Wires for this design approach as below.

18.1 Database

If using the pole database, the following fields are needed:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>Unique code</td>
</tr>
<tr>
<td>Length</td>
<td>Full length of pole from butt to tip</td>
</tr>
<tr>
<td>Default Sinking</td>
<td>Sinking depth</td>
</tr>
<tr>
<td>Default Height</td>
<td>Height of pole tip above ground. Will equal length - sinking depth</td>
</tr>
<tr>
<td>Diameter average</td>
<td>Average above ground diameter. Used to calculate wind load on pole</td>
</tr>
<tr>
<td>Strength: ultimate</td>
<td>Ultimate strength capacity of pole (usually provided by pole manufacturer)</td>
</tr>
<tr>
<td>Strength: vertical</td>
<td>Vertical strength capacity</td>
</tr>
<tr>
<td>Round Pole</td>
<td>Tick if a round pole</td>
</tr>
</tbody>
</table>

Optional fields:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Description</td>
</tr>
<tr>
<td>Material</td>
<td>Eg wood, steel</td>
</tr>
<tr>
<td>Weight</td>
<td>In kg or lbs. Used for assessing vertical load</td>
</tr>
<tr>
<td>Remarks</td>
<td>Remarks</td>
</tr>
</tbody>
</table>

The following fields are not used for working stress calculations:

- diameter, tip long
- diam GL longitudinal
- Strength: wind 1
- diam butt longitudinal
- strength: no wind
- Strength: wind 2
18.2 Load combinations (Options)

Options must be set so the load cases you want to assess are available. Below is an example of values suitable for the maximum wind load combination as shown in AS-7000:2010.

![Figure 45: Load combination settings]

18.3 Pole top allowance

This option is set on the tipload tab of Options. Pole top allowance is a value that makes allowance for crossarms, insulators etc. It is usually set to 1 (ie no allowance) for limit state calculations as these items are accommodated by other variables.
19 Set up for rectangular poles

The default pole type is a round pole. This means that the load on the pole from wind from any direction is the same. When using a rectangular pole the wind load on the pole will vary depending on the area of the pole presented to the particular wind direction being used (the tipload module calculates tip load under wind from all directions and reports the worst case).

Set up Poles 'n' Wires to use rectangular poles as follows:

19.1 Poles database

These fields are used to describe the pole:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diameter: average</td>
<td>Average size of pole face (mm or inches)</td>
</tr>
<tr>
<td>Diameter: average transverse</td>
<td>Average size of pole side (mm or inches)</td>
</tr>
<tr>
<td>Strength: ultimate</td>
<td>Ultimate limit Strength of pole on pole face (line)</td>
</tr>
<tr>
<td>Strength: transverse</td>
<td>Ultimate limit Strength of pole on pole side (cross line)</td>
</tr>
</tbody>
</table>

The following fields are not used for rectangular poles:

- Diameter - tip
- Diameter - Ground line
- Strength: wind 1
- Diameter - butt
- strength: no wind
- Strength: wind 2

19.1.1 Round pole field

Must be unticked for a rectangular pole

19.2 Tipload module

When selecting a rectangular pole from the database its properties are shown in the window. These values can be overwritten.

Orientation is the direction of the face of the pole and tiploads are resolved relative to this direction.
19.2.1 Face and side

This is an extract from the Busck pole data:

It doesn’t matter which side you take as face or side as long as you are consistent. If for the above example you take the 475mm dimension as the face then the corresponding database entries will be:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diameter: average (mm)</td>
<td>475</td>
</tr>
<tr>
<td>Diameter: average transverse (mm)</td>
<td>255</td>
</tr>
<tr>
<td>Strength: longitudinal (kN)</td>
<td>7</td>
</tr>
<tr>
<td>Strength: transverse (kN)</td>
<td>22</td>
</tr>
</tbody>
</table>

Tipload results will be shown both as polar (tipload value and direction) and resolved into load in direction of face and side.

6 This dimension is actually the ground line dimension, so you would need to obtain the correct average above ground dimension.
20 Set up for US users

Line design in the USA uses some terms and approaches that are different to the term used in Poles 'n' Wires. This section gives guidelines for US users.

20.1 Sag-tension calculations

Software commonly used in USA for line design uses the term sag-tension to show the loads that wind and conductor tensions exert on poles. Poles 'n' Wires uses the term tipload.

Tipload is the summation of conductor and wind loads on the pole relative to the tip of the pole, accounting for wind and conductor direction at conductor attachment height. This tipload can then be compared to the pole strength capacity (after applying any factors) to determine if the pole chosen is adequate.

20.2 Conductor sags

The sag of a particular span can be found in the profile by putting the mouse over the circuit in the profile image. See figure 46 - the mouse is over the lower span (circled in green) and the sag and other details are shown in the right margin.

Figure 46: Sag of a span

This sag dimension is mid-span sag allowing for span length, strain section ruling
span, temperature and height difference between attachment heights.

20.3 Tensions

When stringing conductors in the profile you will need to enter a tension. A sag-tension calculator is incorporated into the profile module allowing you to enter load limits and design temperatures. These can be selected and are then displayed in the profile. Alternatively you can use tensions calculated by other software such as sag10.

20.4 Load cases

Before being able to perform tipload calculations you need to set up load cases as required. Relevant specifications will tell you the load cases you need to consider. These may be utility design manuals, the NESC or RUS bulletins.

For example, NESC rule 250B medium loading specifies 4 lb/ft² wind and 0.25 inches ice, ice density of 57 lb/ft³. You would create a load case in Options so this can be modelled by the tipload calculator. Don’t forget to set the ice density on the Sag tension tab as well. See figures 47 and 48.

![Figure 47: Load case rule 250B medium](image_url)
20.5 Pole strength

You need to compare the tipload with the pole's strength capacity. ANSI O5.1-2008 gives strengths for poles commonly used in the US. This data can be used to determine the tipload capacity of the pole, to be compared with the tipload calculation from Poles 'n' Wires.

20.6 Poles 'n' Wires, Sag10 and PLS CADD

All line design software uses algorithms to model the behaviour of the power line under differing conditions. There are two common approaches:

Stress-strain or graphical method

Devised by Thomas Varney, this method is used by Sag10 and PLS CADD. It shows a comparison between initial and final conditions. The US version of Poles 'n' Wires has a sag-tension module that uses this method.

Change of state method

This method uses the change of state equation described in various documents, using final values of modulus of elasticity and temperature coefficients. The international version of Poles 'n' Wires uses this method. Initial conditions can be estimated by using

**Figure 48: Ice definition**

<table>
<thead>
<tr>
<th>Ice/Snow Loadings</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Ice Loading 1 name</td>
<td></td>
</tr>
<tr>
<td>Ice Loading 1 density</td>
<td>.57</td>
</tr>
<tr>
<td>Ice Loading 2 name</td>
<td></td>
</tr>
<tr>
<td>Ice Loading 2 density</td>
<td>.33</td>
</tr>
<tr>
<td>Ice Loading 3 name</td>
<td></td>
</tr>
<tr>
<td>Ice Loading 3 density</td>
<td>.25</td>
</tr>
<tr>
<td>Ice Loading 4 name</td>
<td></td>
</tr>
<tr>
<td>Ice Loading 4 density</td>
<td></td>
</tr>
<tr>
<td>Ice Loading 4 default thickness</td>
<td>ice</td>
</tr>
</tbody>
</table>
a temperature or tension offset.

The NESC does not prescribe the use of a particular approach but the stress-strain method is the one most commonly used in the United States. Both methods have pros and cons and both are just approximations as there are many assumptions and factors that affect the behaviour of overhead lines.

The stress-strain method is integrated into Poles 'n' Wires so that users who are accustomed to that method can feel comfortable using Poles 'n' Wires. Or you can use the tensions generated by sag10 or other software to create a profile that models the line in the same way.

The steps are outlined below:

1. in Options>General select “US customary/imperial”

2. in Options>sag tension, create an ice loading you require. Enter a label, density and thickness (figure 49)

3. in Options>Load combinations, using Load combination 7, enter values corresponding to the worst case load you want to model. Load combination 7 is a special load allowing you to enter the constant value for k specified in NESC. (figure 50)

4. save the options
20.6.1 Creating the conductor segment in the profile

Instead of entering the temperature for each condition, enter the tension for the strain section for each load case you want to show in the profile, as calculated elsewhere. An example is shown below.

If one of the labels corresponds to load combination 7 in Options (heavy in this example) the data from that load is used in calculating the loaded conductor weight, used to calculate sags and tensions.
21 Stay module

This module allows you to determine loads in one or two stays attached to a pole given the tipload on the pole and the stay configurations. If you enter the stay wire type it also gives percentage loading in the stay.

The module opens showing the one stay page. Most of the information you need to enter is the same for one or two stays.

21.1 Required information

- **tipload in kN.** You will calculate this in the tipload module. The tiploads for different load cases need to be considered separately because they will usually be in different directions.
- **Direction of the tipload.** This can be actual compass direction or any nominal reference direction as long as the stays are relative to the same zero direction.
- **Pole height.** Height above the ground that the tipload is applied to the pole, usually the pole tip.
- **Attachment height.** Of the stay wire.
- **angle to ground.** Angle between the stay and the ground shown by Ø in figure 51.
• Direction. Relative to the same zero direction as the tipload.

21.2 Optional data

• Pole ID. For reference
• Pole group and diameter. Not currently used
• Stay wire. Enter a conductor code from the database. If Only show stay wire is ticked the conductor database is filtered on the “Stay wire” property and only conductors indicated as stay wires in the database are available here. This text entry has an auto-complete feature. Start typing the conductor code and matching codes will be listed. Double click in the text box to display the Search conductor window (See section 12).

21.3 Results

Click Calculate to generate the result. Loads in the stay wires are shown with the net vertical download on the pole due to the stays. If a stay wire has been entered the percentage loading in the wire is also shown.

21.4 Sidewalk/Cantilever stay

The tab labelled Sidewalk stay allows the calculation of the tension in the stay wire for a cantilever arrangement.

Required values are:

• pole height (height of application of tipload) (ht)
• applied tip load (kN)
• distance from centre of pole to stay anchor point (D)
• angle of stay wire to vertical (Ø)

• If Ø is unknown the program will calculate it from other values:
  ◦ height of cantilever arm (hc)
  ◦ length of cantilever arm (x)
  ◦ diameter of pole at ground level (in mm)

Enter values as required and click Calculate. The tension in the stay wire will be displayed.

21.5 Other functions

21.5.1 Print

This generates a summary PDF report.

21.5.2 Copy

This functions copies the data entered on the one stay tab to the two stay tab. Used if you plan to use one stay then realise two stays will be required.

21.5.3 Clear

Clears all entered data and results

21.6 Calculation methodology

This calculator is suitable for the common arrangement of one stay opposing the resultant tipload, or two stays sharing the load. The pole is modelled as a column hinged at ground level, a suitable assumption for a distribution timber pole\(^7\). The tipload and stay reactions are assumed to be in static equilibrium.

\(^7\) See section 5.2.2 *Design of Guyed Electrical Transmission Structures*. American Society of Civil Engineers
22 Sag calculator

This module allows you to derive the mid-span sag from field measurements of clearances or a wave/pulse on the line.

Click the tab to use one of the two methods.

22.1 Field measurements

Enter the data you have. You require:

- pole attachment heights. If the poles are not on level ground you will need to adjust your measurements to allow for the height difference at the pole bases.
- In-span measured height. This is the clearance taken at the “distance from pole 1”.
- ground offset. If there is a rise or dip at the location when you have taken the in-span height enter the offset height, otherwise zero. A dip is a negative value.
- Span length

Click calculate to show the mid-span sag.

Click print to print a screen capture of the window

22.2 Wave/swing sag

Enter the number of waves then the time for these waves. Click calculate to show the mid-span sag.
This is a simple calculator used to calculate the tip load capacity of a Pole.

Enter the Pole Length and sinking details.

Enter the Pole Footing Width:

<table>
<thead>
<tr>
<th>Backfill type</th>
<th>Use this dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Natural Backfill</td>
<td>average diameter of the pole below the ground</td>
</tr>
<tr>
<td>Full Concrete Foundation</td>
<td>diameter of the bored hole</td>
</tr>
<tr>
<td>Concrete Stabilised Soil</td>
<td>mean of the average diameter of the pole below the ground and the diameter of the bored hole</td>
</tr>
</tbody>
</table>

Select the soil classification in the grid by clicking in the grey row header on the left of the grid.

Click Calculate to calculate the limit of foundation capacity in kN. This result is the ‘foundation limit’ of the pole and is still subject to the ‘strength limit’ of the pole.

### 23.1 Load factor

The calculation in this module is based on a working stress approach and so includes a safety factor. In order to use this module for limit state design calculations you need to alter the factor. Some suggestions follow:

1. for working stress/safety factor calculation enter 1
2. for limit state sustained load enter 0.5
3. for limit state maximum wind load enter 1.8

The factors for cases 2 and 3 are derived as follows. The assumed safety factor is 2.5
(see ENA C(b)1 1991 page 14). A typical value for strength reduction factor (SRF) for
maximum wind load is 0.72 (see AS1720.1 and Ergon Energy’s distribution design
manual sections 5 and 10; table 6.2 AS7000:206 recommends 0.8 – 1.0). A typical value
for SRF for a sustained load is 0.2. Hence

\[
2.5 \times 0.72 = 1.8 \quad \text{and} \quad 2.5 \times 0.2 = 0.5
\]

23.2 Calculation method

This Foundation Capacity calculator is based on the formula in C(b)1 1991 for safety
factor design.

Energy Networks Association provides a free software tool to perform foundation cal-
culations using the Brinch-Hansen method. This tool is available for free download
from the Downloads page on our website http://ipowermation.com. PowerMation does
not provide any support in the use of this tool. There is documentation accompanying
the software.
24 MES Calculator

The Mean Equivalent Span (MES) or Ruling Span (RS) is a theoretical 'average' span length that approximates the behaviour of spans within a strain section. Larger spans tend to dominate in the calculation. MES becomes important in strain sections comprising varying span lengths when determining sag at other than the standard temperature.

The MES calculator allows you to enter span lengths one at a time. The MES and total length is calculated as you enter spans.
25 Batch tipload add-on

This module permits the processing of pole circuit and load data for many poles in one procedure. Field data, gathered by surveying equipment, can be formatted in a spreadsheet or CSV file as shown below. Tensions will be calculated from attachment height and midspan measurements, or can be specified as %CBL or kN. A report is generated as a CSV giving pole ID, no wind (everyday) load and maximum wind load.

The module is located on the main window under Functions>Add-ons and is only available upon payment of an additional licence fee.

![Batch tipload window](image)

You need to set up the process by entering information as described.

The source spreadsheet is a set of repeated data with this format:

**Line 1:**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pole ID</td>
<td>Pole length</td>
<td>Sinking depth</td>
<td>Height above ground</td>
<td>Average above ground diameter</td>
<td>Number of circuits</td>
</tr>
</tbody>
</table>

Each subsequent line (the number of subsequent lines must correspond with the value in column F). Some columns are not used for backwards compatibility with version 6.
<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Circuit ID</td>
<td>J</td>
<td>Not used</td>
</tr>
<tr>
<td>B</td>
<td>direction</td>
<td>K</td>
<td>Not used</td>
</tr>
<tr>
<td>C</td>
<td>Is this a stay? (y or n)</td>
<td>L</td>
<td>Not used</td>
</tr>
<tr>
<td>D</td>
<td>Conductor code (from database)</td>
<td>M</td>
<td>Not used</td>
</tr>
<tr>
<td>E</td>
<td>Number of conductors</td>
<td>N</td>
<td>Not used</td>
</tr>
<tr>
<td>F</td>
<td>Attachment height</td>
<td>O</td>
<td>Left attachment height</td>
</tr>
<tr>
<td>G</td>
<td>Span length</td>
<td>P</td>
<td>Right attachment height</td>
</tr>
<tr>
<td>H</td>
<td>MES/RS</td>
<td>Q</td>
<td>in-span clearance</td>
</tr>
<tr>
<td>I</td>
<td>Not used</td>
<td>R</td>
<td>Distance from left pole that Q is taken</td>
</tr>
</tbody>
</table>

The results are saved as a PDF file. Enter or browse to a location and file name.

Enter the assumed conductor temperature. The suitable value for this is the assumed temperature of the conductors at the time when the field measurements were taken.

You can optionally save each tipload calculation as a separate tipload project file (which can be opened by the tipload module). If you want to do this tick the save box and enter or browse to a directory location where the files will be saved.

Load combinations. As for the tipload module select which load combinations you want to calculate.

Click Process to begin. A bar shows the progress of the calculations.

If a circuit is to represent a stay, enter y in column C, the attachment height on the pole in column F and the angle between the stay wire and the ground in column E. Leave columns G to R blank.
26 Differences - versions 6 to 7

This is a list of differences in behaviour or method between version 6 of Poles ‘n’ Wires and version 7, for your easy reference.

26.1 Uplift

Version 7 shows uplift on one wire/insulator only. Version 6 shows uplift on the cross-arm ie it has been multiplied by the number of conductors.

26.2 Tipload modules

Version 6 has separate working stress and limit state modules. Version 7 has one tipload module that can be set up for working stress or limit state calculations. See sections 17 and 18.

26.3 Pole top allowance

This allows for crossarms, insulators etc by multiplying the wind load on the pole by the specified value. The default is 1. In version 6 this variable is used by the working stress tipload module (default value is 1.1) but is not used by the limit state module. In version 7 this variable is applied to all tipload calculations.

26.4 Plant database

In version 6 the value for Offset is horizontal offset of the centre of mass of the plant item from the pole axis (see version 6 user manual section 16.2). In version 7 the offset is the distance of centre of mass from the side of the pole. This allows for different sized poles (the pole radius at the attachment height is calculated by the program).
27 Calculation methodology

1. Mean Equivalent Span (ruling span) is calculated using horizontal span lengths in accordance with AS7000:2010 section S5:

   It is accepted practice to use the level span formula (S3) for deriving the ruling span that is subsequently used for tension change calculations.

2. The program defaults to using the “final conditions” approach taken by AS-7000:2010 and many other standards.

3. The stay calculator is suitable for the common arrangement of one stay opposing the resultant tipload, or two stays sharing the load. The pole is modelled as a column hinged at ground level, a suitable assumption for a distribution timber pole. The tipload and stay reactions are assumed to be in static equilibrium.

---

8 See section 5.2.2 Design of Guyed Electrical Transmission Structures. American Society of Civil Engineers

9 ANSI O5.1-2008 Abstract
28 Definitions and Terms

28.1 Blowout

Blowout is the horizontal midspan distance when wind (at the wind pressure defined in Options) blows perpendicular to the line, between the conductor and the position the conductor hangs in with no wind. In Poles ‘n’ Wires no allowance is made for suspension insulator swing. Looking from above blowout looks like this:

28.2 Glossary

- Ruling span (RS) and Mean Equivalent Span (MES) are interchangeable.
- Conductor breaking load (CBL), Ultimate tensile strength (UTS) and Rated Breaking strength (RBS) are interchangeable.
29 Standards

Options available to select in the General tab in Options are

AS/NZS7000:2016

NESC:2017

Kenya Distribution Standards

Western Power Based on AS7000 plus Energy Safety requirements.